
Rename dialog box
Allows you to change the name of an album file without breaking any links.

Original album file name Displays the path and folder of an album.
New album file name Enter a new filename for the album.



Backup dialog box
Allows you to save an album and its associated files in a different location.

Backup album to folder Enter the location for the backed-up files or select one from the folders list. (All the 
original files in that folder are removed and replaced by the backed-up files.)

Folders list Displays all existing folders in the current drive.
Drives Select the drive for the backed-up album.
Backup selected files only Check to backup the files of only the selected thumbnails.
Compress files Check to compress files with a ZLIB compression scheme and create smaller backed-up 

files.
Information list Displays the total size of the file to backup and available disk space in the current drive.
Browse Click to search for other files or folders.
Network Click to connect to a network. 



Restore dialog box
Allows you to retrieve a backed-up album and its source files.

Restore album from folder Enter the source path and folder or select from the folders list, the album to 
restore.

Folders list Displays all existing folders in the current drive.
Drives Lists all available drives.
Information list Displays the number of selected files and disk space required to restore the all the files.
Browse Click to search for other files or folders
Properties Click to display more information about a selected album.
Network Click to connect to a network. 
Restore to Select where to restore the selected album and enter the folder name. (If the specified folder 

does not exist, Album creates it.)



Sharing dialog box
Allows you to control the access to albums shared over a network.

Active album options Select the active album's access mode for the current user.
Sharing mode options Select the active album's access mode for other network users.

Note: "Read/Write" access mode plus a "Do not share" sharing mode allows you to change an album's properties.



Album Properties dialog box
    General
    Fields
    Advanced 
    More

Allows you to edit or set the attributes and parameters of an album.
Album title Enter a new album title or edit the current one. (An album title can hold up to 23 characters).
Size Select a size for the thumbnails. 
Compression Select the thumbnail compression scheme. 
Color Select the color palette to use for the thumbnails.
Description Edit or add information about the album to better understand the purpose or contents of this 

album.
Restore Click to delete all edited information and restore to the last saved settings.



Effect of resolution on thumbnail size
Here are some examples of thumbnails sized at different 
resolutions:

640 x 480 (pixels) Full Screen at:
32 x 32 Displays 11 thumbnails across.
96 x 96 Displays 4 thumbnails across.

800 x 600 (pixels) Full Screen at:
32 x 32 Displays 14 thumbnails across.
96 x 96 Displays 5 thumbnails across.

1024 x 468 (pixels) Full Screen at:
32 x 32 Displays 18 thumbnails across.
96 x 96 Displays 7 thumbnails across.

Album Properties dialog box
    General
    Fields
    Advanced
    More

Field name Enter the field name to edit.
Field type Click on the appropriate Field type for the field name.
Add Click to add the new Field name and Field type to the Fields list.
Change Click to change the Field type of the selected Field name with the new one. 
Remove Click to delete the selected field from the fields list.
Total fields Displays the total number of fields in the current album. 
Fields list Displays all the existing fields and information. 
Restore Click to delete all edited information and restore it back to the last saved settings.

Note: Changes in the Field types are only allowed in user-defined Field names.



Field data restrictions
Number Accepts numeric data from 0 to 

4,294,967,294. Negative numbers and decimals are not 
valid.

Date Uses the format defined in the Date of the 
Regional Settings dialog box from the Windows Control 
Panel.

Text Holds up to 255 characters.
Filename Accepts up to 259 characters.
Keyword Each Keyword field accepts up to 32 

keywords and each Keyword item can hold up to 255 
characters. 

List Each List field accepts up to 32 values and 
each List value can hold up to 255 characters.

Memo Accepts up to 65,635 characters.

Album Properties dialog box
    General
    Fields
    Advanced
    More

Allows you to monitor file activities of a folder.
Folder Enter the folder for Album to monitor for any changes. 
Browse Click to search for other folders.
File types Enter the file extension ("*.ext") or select from the file formats drop-down list, the types of files to 

monitor. (You can select several file formats.)
File formats list Click on the file format(s) to include in monitoring.
Enable folder monitoring Check to monitor the defined folder.
Password Set a password for access security. (Passwords can be up to 22 characters.)
Verify Enter the password again to make sure you typed it correctly.



This allows you to immediately update your album for any file deletions or additions. You then don't have to insert 
thumbnails to an album or remember to insert a thumbnail whenever you create a file in another program. Select 
multiple types of files to monitor from the File types list (Allows you to include up to 26 File types).



Album Properties dialog box
    General 
    Fields
    Advanced
    More

Displays the following album information:
Name Displays the path and filename of the active album.
Size Displays the memory size of the active album.
Creation date Displays the date when the active album was created.
Date last saved Displays the date when the last edited version was saved.
No. of records Displays the total number of thumbnails in the active album.
Mark file Displays the location of the Mark file associated with the album.



Insert dialog box
    Files
    Folder

File name Initially shows the file extensions of all the files contained in the open folder. Enter the path and 
name of the files to insert or select from the Files list.

Files list Lists all files in the current folder. Click with the Shift key to select a range of files or click with the 
Ctrl key to select individual ones.

List files of type Select the types of files to display in the Files list.
Insert files selection Select from All files, Modified files, or New files.
Keep field data intact Check to preserve an album's data fields whenever the source file has conflicting 

data fields with the album.
Do not create thumbnails Check to display only the filename. Clear to display a thumbnail representation 

and the filename.
Write error and journals to file Check to collect any errors that may have occurred when collecting 

thumbnails and save them into the Journal.txt file in your local Windows folder. This prevents the insertion process 
from stopping when problems occur.

Folder Displays the current folder.
Folders list Displays all existing folders in the current drive.
Drives Lists all available drives.
List files of media Select the type of media files to display in the Files list.
Insert  Click to add the selected files into the active album. (The Album program only allows you to insert 

100 thumbnails per album.)
Close Click when done inserting.
Options Define the format specific save options for the selected format. (Not all file formats have options.)
Browse Click to search for other files or folders. 
Properties Click to display the selected file's statistics.



Insert dialog box
    Files
    Folder

Insert files Initially shows all the file extensions contained in the open folder. Enter the folder to insert 
thumbnails from or choose from the folders list by double clicking on it.

Folder Displays the current folder.
Folders list Displays all existing folders in the current drive.
Drives Lists all drives available.
List files of media Select the type of media files to display in the Files list.
List files of type Select the type of files to display in the Files list.
Collect files in all subfolders Check to include the files in the subfolder contained in a selected folder.
Insert files Select from All files, Modified files, or New files.
Keep field data intact Click to preserve album data fields if the source file has conflicting data fields with 

the album.
Do not create thumbnails Check to display only the filename. Clear to create thumbnails for the inserted 

files.
Write errors and journals to file Check to log any errors that occur while inserting thumbnails and save 

them into the Journal.txt file in your local Windows folder. When this option is active, the insertion process runs 
uninterrupted and does not stop when errors occur.

Insert Click to insert files from the selected folder into the active album. (The Album program only allows you
to insert 100 thumbnails per album.)

Close Click when done inserting.
Options Define the format specific save options for the selected format. (Not all file formats have options.)
Browse Click to search for other files or folders. 



Search dialog box
Allows you to define a search criteria to match with thumbnails in an active album.

Search Type Select a Field to search on from the drop-down list to match with thumbnails.
Search Operator Select an Operator to use in determining the relationship between more than one search 

criteria.
Search criteria When "Contains" is selected as a Search Operator, enter the data for searching.
Operators and match options Check the boxes for specific file features to use in searching.
Edit criteria Click to define more detailed conditions in the search.
Add Click to include the defined search condition to the Search criteria list.
Change Click to replace a selected search condition in the Search criteria list, with the newly defined one.
Remove Click to delete a selected search condition from the Search criteria list.
Search criteria list Displays all defined search conditions and their operators.
Search options Check the location for searching.
Save Query Click to save a defined search criteria for future use.
Load Query Click to retrieve previously saved search criteria.
Action to take Select whether to display only the matching results or to select all matching thumbnails after 

searching.

    Logical Operators



Operators are characters or phrases that help define a range in a search. Other operators are self-explanatory, but 
there are two that require clarification for certain Search Types. To search for thumbnails with data in their searched 
Field, select Contains. To search for thumbnails with no data in their searched Field, select Empty.



Depending on the Search Type selected, the conditions you can set for the search, varies. In some search types, you
can define additional search conditions for more detailed processing.



This button is not available for all Search Types.



Edit Search Criteria dialog box
Allows you to define or edit search conditions. Depending on the selected Search Type, each has its own list of 
search operators and set of conditions you can define to do a more detailed search.

Search criteria Enter the data for searching.
Match case Check to display only the exact data match, i.e., the upper and lower cases in a query are 

considered.
Match whole word Check to search for only the occurrences of the letters defined in a query. Clear to 

search for all occurrences of the letters defined in a query even if it is only part of a word. Unlike in the Match case, 
this search does not consider the upper and lower cases, but only the occurrences of the letters.

Operators Select an Operator to use in determining the relationship between more than one search criteria.
Delimiter Select a delimiter to use when a search query is more than one word and must be treated as one. 



Edit Search Criteria dialog box
Allows you to define or edit search conditions for a selected search type.

Search criteria Enter the data for searching.
Start with Check to search for thumbnails with words that begin with the entered text.
Keyword/Value locator Enter the first few letters of the keyword/category to go down nearer to the desired 

data in the Keyword/Values list.
Keywords/Values list Displays all keywords/values in an album.
Operators Select an Operator to use in determining the relationship between more than one search criteria.
Delimiter used in this criteria Select a delimiter to use when a search query is more than one word and 

must be treated as one. 



Edit Search Criteria dialog box
Allows you to define or edit search conditions for a selected Search Type.

Search criteria Enter the data for searching.
Operators Select an Operator to use in defining the relationship between more than one search criteria.
Delimiter used in this criteria Select a delimiter to use when a search query is more than one word and 

must be treated as one. 



Search by Marks dialog box
Allows you to define or edit search conditions for a Mark Search Type.

Search criteria Enter the data for searching.
Marks list Select the marks to use for searching.
Operators Select an Operator to use in determining the relationship between more than one search criteria.



Save Query dialog box
Allows you to include a defined search criteria in the existing queries list for future use.

Query name Enter the filename for saving.
Existing queries list Displays other queries previously saved.



Load Query dialog box
Allows you to display, load, or delete previously saved queries.

Existing queries Select a previously saved query to display, load, or delete.
Remove Click to delete a selected query from the list.
Query content Displays a selected query's search criteria. 
Load Click to retrieve a selected query.
Close Click to close the Load Query dialog box.



Sort dialog box
    Basic
    Advanced

Allows you to define the order of thumbnails in an album.
Sort by Select a mode to use for sorting.
Sort mode list Lists all the sort mode commands to choose from. Click on a desired mode to apply.
Sort order Check whether to start sorting from first to last (ascending), or last to first (descending).



Sort dialog box
    Basic
    Advanced

Allows you to define the order of thumbnails according to the media type of their associated files.
Media types Select a media type for sorting.
Sort by list Lists all the parameters of a selected media type. Select a parameter for sorting.
Sort order Check whether to start sorting from first to last (ascending), or last to first (descending).



Import/Export dialog box
    File
    Import Fields
    Export Fields

Allows you specify a database file to import/export.
File name Enter the path and name of a file to import/export or select from the files list.
Files list Lists files in a current folder.
List files of type Select a file format to display in the Files list. 
Folders list Displays all existing folders in the current drive.
Drives Select a drive where the folder for importing/exporting is located.



Import/Export dialog box
    File 
    Import Fields
    Export Fields

Displays the input file's fields and the existing fields in the current album. 
Fields in input file list Displays all fields in the input file.
Fields in album Displays all fields in the album. Check the fields to match with the selected input file.
Match field values in __ with album's field Check to compare values in the input list fields to that of the 

album. 
Treat first record in file as field names Check to display the field title in the input file list.
Character set Select a text format to use when importing.



Import/Export dialog box
    File
    Import Fields 
    Export Fields

Allows you to select fields to export.
Export fields list Displays all fields in the current album. Check the fields to export.
Character set Select a text format to use for exporting.
Store field names as first record in file Check to save exported field names in the first row of the file 

instead of in a column.



Convert dialog box
Allows you to specify a file format and data type for converting the source file of a thumbnail.

Convert file format to Select a file format to use for converting.
Convert data type to Select a data type to use for converting.
Option Define the format specific save options for the selected format. 
Converted files options Check the option(s) to specify the destination of the converted files.
Browse Click to search for other files or folders.
Delete original files and remove from album Check to delete the original files from the disk and album. 



Print dialog box
Printer Displays the current default printer.
Copies Enter the number of copies to print.
Scale to Fit the Page Check to scale the images to print as large as possible on the output page. Clear to 

print the image at the size determined by its resolution.
Center Image Horizontally Check to print an image centered from left to right.
Center Image Vertically Check to print an image centered from top to bottom.
Printer Click to modify the printer settings.



Move/Copy Files dialog box
Moves or copies source files to a new location.

Move/Copy files to folder Displays the current folder. Specify a folder for moving of copying files to.
Folders list Displays all existing folders in the current drive.
Drives Select a drive for the moved/copied files.
Insert copied files to Album Check to insert the thumbnails of the copied source files into another album.
Album  Select an album to insert the thumbnails of the copied files to.
Information Displays the drive and file information. (No. of selected files, total size, and available disk space

on the current drive.)
Browse Click to search for other files or folders.
Network Click to connect to a network. 



Rename dialog box
Allows you to change the name of a source file without breaking the link to its thumbnail.

From Displays the source filename of a selected thumbnail.
To Enter a new name for the source file.



Associate dialog box
Allows you to associate thumbnails with a given extension with an application. 

Files with extensions Enter the file extension of the thumbnails to associate to the application.
Associate with program Specify the application to view or open thumbnails with the specified file 

extension.
Program application list Displays all available program applications.
Browse Click to search for other files or folders.



Create/Remove Folder dialog box
Allows you to create a new folder or remove an existing one.

Folder name Displays the current folder. Enter a folder name to create or remove.
Folders list Displays all existing folders in the current drive.
Drives Select a drive for the folder.
Browse Click to search for other files or folders.
Network Click to connect to a network. 



New Group dialog box
Allows you to create a group of programs to add to the Tool panel.

Program group Check to enter a new group of programs.
Group name Enter a name for the new group of programs.
Program icon Check to enter a program name, description, and location of programs to add to the defined 

program group.
Description Enter a program description for quick identification of the application. (Optional.)
Command line Enter the path and extension of the program to insert.
Working folder Enter the folder where the program file is located.
New Click to add a new program icon to the Tool panel.
Close Click when done adding.
Browse Click to search for other program files.



Delete dialog box
Allows you to remove the selected program group and/or icons from the Tool panel.

Delete current program group Check to delete the currently selected program group from the Tool panel.
Group Displays the current program group.
Delete program icon from current group Check to delete the currently selected program icon.
Icon Enter or select a program icon to delete from the drop-down list.



Tool panel Properties dialog box
Displays the current program group name and program icons for any modification.

Program group Check to edit the current program group name.
Group name Displays the current program group name.
Program icon Select from the drop-down list a program icon to edit/display.
Description Displays the selected program icon's description for editing.
Command line Displays the selected program icon's path and extension for editing.
Working folder Displays the selected program icon's folder for editing.
Browse Click to search for other files or folders.



Configure dialog box
Allows you to change the location of the Tool panel.

Left Check to place the Tool panel hugging the left side of an album workspace.
Right Check to place the Tool panel hugging the right side of an album workspace.
Floating Check to place the Tool panel anywhere on the monitor screen. Click on the Tool panel title bar and

drag it to the desired location.



Run dialog box
Allows you to run other programs that are not included in the Tool panel.

Command line Enter the path and extension of a program to run.
Run minimized Check to immediately minimize the Album program after opening the other program.
Browse Click to search for files or folders.



Edit Marks dialog box
Allows you to add or edit mark names in an album.

Mark name Enter a mark name to add or edit.
Marks list Displays existing marks in an album.
Adopt marks from album Select marks from other open albums in the workspace.
Clear All Click to delete all mark names from the list.



Load Marks dialog box
Allows you to retrieve previously saved marks.

Look in Select a folder where previously saved mark files are located.
View the contents of the next higher folder in your system.
Create a new folder.
Lists the names.
Lists the names with statistics.
File name Enter the filename to load.
Files of type Select the mark file extension (*.mrk) to display only mark files.
Merge with original marks Check to add incoming mark names to your current list.
Replace original marks Check to delete the current mark names and replace them with incoming ones.



Load/Save dialog box
Allows you to load/save files.

Look in/Save in Define a folder for loading/saving.
View the contents of the next higher folder in your system.
Create a new folder.
Lists the names.
Lists the names with statistics.
File name Enter a filename for loading/saving.
Save as type Select a file format extension.
Load/Save Click to load/save file.
Browse Click to search for other files or folders.



Convert to Keywords dialog box
Adds the selected marks to a Keyword field. This also allows you to choose whether to keep the converted marks on 
thumbnails, clear them, or delete the mark names from the Mark panel after conversion.

Keyword fields list Displays all existing field names with Keyword as Field type. Select which field name to 
add the selected marks to.

Clear marks from selected thumbnails Check to remove the selected marks from the specified thumbnails
after conversion.

Clear mark names from panel Check to delete the converted mark names from the Mark panel.



Acquire dialog box
Allows you to acquire an image by specifying the following information:

Save in Enter a folder to save the acquired image to.
View the contents of the next higher folder in your system.
Create a new folder.
Lists the names.
Lists the names with statistics.
File name Enter a filename for saving.
Save as type Select a format for the new file.
Increase file number by two Check to save scanned images to filenames numbered in increments of two. 

(This is useful when scanning multiple pages with information on both sides to keep the file order identical to the page
order.)

Acquire sound annotation Check to acquire images along with their annotation files. (Only available when 
using Canon PowerShot Camera.)

Delete acquired image files Check to not save acquired images in your hard disk.
Automatically numbered Check to automatically number each successive image input.
Image data type supported Displays the data type supported by a selected file format.
Save Click to save an acquired image.
Option Click to select the save options for certain file formats.
Browse Click to search for other files or folders.



Filenames can be entered with or without a file extension and automatically numbered in consecutive numbers. If no 
extension is entered, the extension selected in the Save as type is automatically added in.



Select Source dialog box
Allows you to define a source device to use for acquiring.

Select a data source Select an installed TWAIN device to use when acquiring images.



Scroll To dialog box
Allows you to view a thumbnail right away.

Scroll to Enter the index number of a thumbnail to go to.
Thumbnails list Lists all thumbnails in the current tab. Click on a thumbnail from the list to go directly to.



Auto Scroll dialog box
Automatically scrolls through all the thumbnails in an album screen by screen.

Delay time (in seconds) Enter a delay time for displaying a screen of thumbnails before scrolling to 
another.

Note: Press the space bar to pause/resume scrolling, Esc key to stop.



Layout dialog box
    Thumbnail
    Attribute 
    Filename

Allows you to change the information displayed when in a Thumbnail display mode. 
Show fields window Check the boxes of the desired fields to show and enter the number of lines for each 

selected field.
Total number of lines Displays the sum of all the lines for the selected fields.
Text area width Select a width for the text.
Thumbnail format Select a display format for a thumbnail.
Show file name with full pathname Check to display the full path name of the thumbnails. Clear to display 

just the filename.
Preview Click to view a defined layout before applying.
Same As Click to apply a layout of another open album in the workspace.



Layout dialog box
    Thumbnail
    Attribute
    Filename

Allows you to change the information to display when in an Attribute display mode.
Show fields window Check the boxes of the desired fields to show and enter the number of lines for each 

selected field.
Total number of lines Displays the sum of all the lines of selected fields.
Show thumbnail Check to display thumbnails when in an Attribute display mode.
Thumbnail format Select a display format for the thumbnails.
Show file name with full pathname Check to display the full pathname of the thumbnails. Clear to display 

just the filenames.
Preview Click to view a defined layout before applying.
Same As Click to apply a layout of another open album in the workspace.



Layout dialog box
    Thumbnail 
    Attribute
    Filename

Allows you to change the information displayed when in a Filename display mode.
Show fields window Check the boxes of the desired fields to show and enter the number of characters for 

each selected field.
Total number of fields Displays the sum of all the selected fields.
Show file name with full pathname Check to display the full pathname of thumbnails. Clear to display just 

the filenames.
Preview Click to view a defined layout before applying.
Same As Allows you to apply a layout of another open album in the workspace.



Same As dialog box
Allows you to use another open album's layout.

Apply layout Check the layout(s) to apply when in one of the different modes.
From album Select from the list of open albums in the workspace, the album with its layout to apply.



Tile Album Window With dialog box
Allows you to display Album alongside another application.

Choose a window to tile with Album Displays a list of open applications. Select an application to tile with 
Album.

Tile method options Decide how to arrange the desktop.



Category dialog box
Allows you to add or select items to or from the values list.

Select list item from table Lists all items defined in a selected category with List as Field type. Click on an 
item to place on a selected thumbnail.

Enter new list item Enter a new item to add to the current items list.



Keyword dialog box
Allows you to add values or items to a selected field.

Current keywords in field Displays all the items in a selected field.
Current keywords available Displays all the keywords in an album. Click on an item to place on a selected 

thumbnail and to be added to the Current keywords in field list.
New keyword Enter a new item to add to the two lists.
Add Click to add a new keyword to the two lists.
Remove Click to delete an item from the Current keywords in field list.
Remove All Click to delete all items from the Current keywords in field list.



Add/Change Annotation dialog box
Allows you to annotate sound, MIDI, video, or animation files to a thumbnail.

Look in Define the folder of the files to annotate.
View the contents of the next higher folder in your system.
Create a new folder.
Lists the names.
Lists the names with statistics.
File name Enter the filename for the file to annotate.
Files of type Select a file format extension to display.
Open Click to annotate a selected file.
Browse Click to search for other files or folders.



Switch To dialog box
Allows you to switch from one album tab to another and display a different set of thumbnails.

Tab value Displays all the different tabs contained in an album. Select a tab value to display the desired set 
of thumbnails.



Move Thumbnail dialog box
Allows you to move thumbnails from one tab to another.

Tab value Displays all the different tabs contained in an album. Select a tab value to display the desired set 
of thumbnails.



Logical Operators
Allows you to quickly search through a vast number of files. 
This is commonly known as the Boolean operators:

Not Does not include thumbnails that have this 
search item.

And Includes thumbnails that have both search 
items.

Or Includes thumbnails that meet at least one of 
the search items. 

( ) Combines criteria together.

If it is easier to find what you are looking for by excluding other thumbnails, select Not as an operator.



If you wish to find thumbnails meeting all of the specified criteria, select And.



If you wish to search for thumbnails that meet at least one of the specified criteria, select Or.



If you have several criteria, some of which must be paired together, use ( ).



Set Text/Background Color dialog box
Select colors for the slide show text and background.

Basic Colors Choose a color to use from the standard Windows color palette.
Custom Colors Choose a color you created and saved from the Custom Colors area.
Define Custom Colors Create a color from a palette showing all available options for your computer.



Font dialog box
Allows you to set a typeface to use in a slide show presentation.

Font Select a desired typeface from the list for the text in a slide show.
Font style Select a style for the selected font.
Size Set a size for the selected font.
Effects Check the effects to apply on the selected font.
Sample display Provides a preview of the defined typeface.



Groups dialog box
Displays all the program groups that you have created for the toolbox. Click the one that you want to display in the 
toolbox.





Using the Batch Manager
1. From the Window menu, choose "Batch Manager" or double-click on an empty area in the workspace.
2. Select the albums from the Albums list to apply an operation to. (Select multiple albums by pressing the mouse 

with the Shift key to select a range of files or the Ctrl key for several individual ones. Click Deselect for any 
incorrect selection made.)

3. Select a command to perform on the selected albums from the Operation drop-down list.
4. Click OK to perform the operation on the selected albums.

    General Procedures Contents



Creating a new album
1. From the File menu, choose "New."  
2. Select a template from the Album templates list.
3. Enter a name for the new album. 
4. Click OK to immediately start inserting thumbnails after creating the album or click Customize to define or 
edit the properties of the selected album template.

    An album from an album
    General Procedures Contents



An album from an album
1. Open the album with the thumbnails you want to insert to a new album.
2. Select the thumbnails to place into the new album.
3. From the Edit menu, choose "Make Album." 

    General Procedures Contents



Opening an album
1. From the File menu, choose "Open." 
2. Select a folder where the album to open is and double-click to display the file names contained in it.
3. Click on or type the name of the album to open. The Album program only allows you to open two albums at a time 
in the workspace. When opening more than one album, press the Ctrl key while selecting files.(Click Properties to 
display information about a selected album.)
4. Click OK.

Note:  You may also drag album files from the Windows Explorer or File Manager into an empty area in the Album 
workspace to open them. 

    Opening album files into the workspace
    General Procedures Contents



Finding files on disk
1. In a dialog box which involves opening or accessing files, click Browse to search for other files or folders.
2. Select the drive and folder to look into for file(s).
3. Enter the filename to search for. You may use wildcards (*.*) to search for a group of files with the same name or 

file extension.
4. Click Scan to search the selected folder and all its subfolders. Matching files are displayed in the Files found list 

sorted in the order specified in the Sort files option.
5. Click on the filename(s) with the Shift or Ctrl key to select files. The Shift key allows you to select a range of files; 

the Ctrl key, several individual ones.
6. Click OK to include the selected files for opening or accessing. 

    General Procedures Contents



Printing an album
1. From the File menu, choose "Print."     
2. In the Thumbnail range option, specify which thumbnails to print.
3. Specify the number of copies to print and check the Collate box to print documents set by set and also 
maintain the page order.
4. If    "Thumbnail Image" is selected, check "Create thumbnails from original files" to get clearer thumbnails. 
However, selecting this option may result in slower printing.
5. Click Page to modify output page settings.
6. Click OK to start printing.

    General Procedures Contents



Deleting an album
From the workspace:
1. Select the album to delete by clicking on its title bar , or if minimized, click on its icon to make it the active one.
2. From the Album menu, choose "Delete." Album prompts a confirmation message.
3. Click "Yes" to continue deletion, "No" to cancel.
From the shelf:
1. From the File menu, choose "Shelf."
2. Select the album from the Albums on Shelf list and click Delete.
3. Click Close when done deleting albums.

Note: The album files are deleted, but the source files remain on your hard disk. 
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Obtaining information
Album Properties

There are several ways to obtain an album's information:
From the File menu, choose "Open". Click on the album's filename and then the Properties button.
Select an album and from the Album menu, choose "Properties."
From the File menu, choose "Shelf." Select an album on the shelf and click Properties.
For backed-up album information, choose "Restore" from the Album menu and click Properties.

System Properties
1. From the View menu, choose "System Properties".
2. Click on any of the three tabs for more information.
3. Click OK to close the dialog box and resume working on the album.

Source file Properties

There are several ways to view the source file information of thumbnails in an album:
Select a thumbnail and choose "Properties" from the Source menu.
Right click on a thumbnail to display a pop-up menu and then choose "Properties" to display the source file 

information. (In a Data Entry display mode, right click within the thumbnail, but outside the Edit pane's data entry area
to display a pop-up menu with the "Properties" command.)
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Using the Album shelf
Putting albums on the shelf:

From the File menu, choose "Shelf." Select an album to place on the shelf from the Albums in workspace list
and click => or double-click on the album's title. Click Close when done.

Right click on an empty area in the workspace. From the pop-up menu, choose "Put on shelf."

Returning albums to the workspace:
From the File menu, choose "Shelf." Select an album to put back into the workspace from the Albums on 

shelf list and click <=. Click Close when done.
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Exiting Album
There are several ways to end an Album session:

From the File menu, choose "Exit."
Double-click on the Album's icon located at the upper left hand corner.
Click on the Album's icon and select "Close."
Click 

 located at the upper right hand corner.
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    Inserting thumbnails into an album 
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    Inserting from a TWAIN device 
    Inserting from other Ulead programs



Files
1. From the Thumbnail menu, choose "Insert."
2. Click the Files tab to insert thumbnails file by file.
3. Select the drive and folder of the files to insert. Click Browse to search for other files or folders.
4. Select the media type and file format of the files to display in the list of files to insert.
5. From the list of files, select the files to insert. (Press the Shift or Ctrl key while selecting files. The Shift key allows 

you to select a range of files; the Ctrl key, several individual ones.)
6. Check "Write errors and journals to file" to generate a report on any problems that occurred while inserting and 

avoid cessation in the insertion process.
7. Click Insert to add the selected files into the active album. (The Album program only allows you to insert 100 

thumbnails per album.)
8. Click Close when done inserting.

    Why select Write errors and journals to file?
    Other ways of inserting thumbnails
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Folders
1. From the Thumbnail menu, choose "Insert."
2. Click the Folders tab to insert thumbnails by collecting files from a selected folder having the specified file formats .
3. Select the drive of the folder to insert. Click Browse to search for other folders.
4. Select the media type and file format of the files to include in the collection of files to insert. 
5. Check "Write errors and journals to file" to generate a report on any problems that occurred while inserting and 

avoid cessation in the insertion process.
6. Select the folder and click Insert to start collecting files. (The Album program only allows you to insert 100 

thumbnails per album.)
7. Click Close when done inserting.

    Why select Write errors and journals to file?
    Other ways of inserting thumbnails
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Inserting from other Ulead programs
1. Run the selected Ulead program where the file to insert is located.
2. From the selected Ulead program's File menu, choose "Save As."
3. In the Save As dialog box, click Album.
4. Select an album to insert the thumbnail representation of the file to or create a new album and then click OK.
5. After the Album dialog box closes, click Save to insert the thumbnail into the selected album .

    Other ways of inserting thumbnails
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Copying a thumbnail to another album
1. Select the thumbnail you want to copy. 
2. From the Edit menu, choose "Copy" to copy the selected thumbnail onto the clipboard.
3. Open an album for the copied thumbnail.
4. From the Edit menu, choose "Paste" to insert the copied thumbnail into the newly selected album.
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Viewing albums in different modes
Using the Standard toolbar:
1. Select an album to view.
2. Locate the Standard toolbar.
3. From the four viewing modes (  Thumbnail, 

 Attribute, 
 Filename, 
 Data Entry), click on the desired mode to change the display on the screen.

Using the View menu:
1. Select an album to view.
2. From the View menu, choose "Mode."
3. Highlight and click on the desired view mode to change the display on the screen.

Using right click:
1. Open an album in the workspace.
2. Right click on an empty area in the workspace to open a pop-up menu. 
3. From the pop-up menu, choose "Mode" and select a mode from the appearing submenu to change the display on 

the screen.

Note: Choose "Layout" from the View menu "Mode" to change the layout of the different viewing modes. This allows 
you to select which information to display in each of the different modes.
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Selecting thumbnails
To select one, click on a thumbnail. (Any other selected thumbnails in the album are deselected.)
To select a range, click on the first thumbnail in the range, then press the Shift key and click on the last 

thumbnail in the range.
To select or deselect individual thumbnails without affecting previous selections, press the Ctrl key as you 

click on a thumbnail.
To select all the thumbnails in an album, choose "Select All" from the Edit menu.
To select all the thumbnails that are not included in the current selection and deselect all thumbnails in the 

current selection, choose "Select Invert" from the Edit menu.
To select the thumbnails matching a defined search criteria, check "Select Matched Thumbnails in the Action

to Take" in the Search dialog box.
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Moving thumbnails from one album to another
1. Select the thumbnails to move to another location. (Use the Shift key with the mouse to select a range of 

thumbnails or the Ctrl key with the mouse to select individual ones.)
2. From the Edit menu, choose "Cut" to remove the selected thumbnails from the active album and move them onto 

the clipboard.
3. Select an album you want to paste the thumbnails into.
4. From the Edit menu, choose "Paste" to insert the selected thumbnail from the clipboard into the selected album.

    Other ways of changing the order of the thumbnails
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Cutting thumbnails from an album
1. Select the thumbnails to move onto the clipboard. (Use the Shift key with the mouse to select a range of 

thumbnails or the Ctrl key with the mouse to select individual ones.) 
2. From the Edit menu, choose "Cut" to remove the selected thumbnails from the active album and onto the 

clipboard.

    Other ways of changing the order of the thumbnails
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Deleting thumbnails from an album
1. Select the thumbnails to delete from the album. (Use the Shift key with the mouse to select a range of thumbnails 

or the Ctrl key with the mouse to select individual ones.)
2. From the Edit menu, choose "Clear." Selected thumbnails are deleted from the album; the source files, however, 

are unaffected.

    Other ways of changing the order of the thumbnails
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Arranging the order of thumbnails
1. From the Thumbnail menu, choose "Sort."
2. Click on the Basic tab to perform sorting by fields or certain file information. Click on the Advanced tab to perform 

sorting by the different types of media files. 
3. For basic sorting, select a sort mode to apply.
4. For Advanced sorting, select a type of media file. Album displays a list of media parameters. Select the parameter 

to apply.

Note: If you wish to retain this arrangement of thumbnails for future use, choose "Save Sequence" from the 
Thumbnail menu. Each thumbnail's index number is reassigned reflecting its new position.

    Other ways of changing the order of thumbnails
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Relinking thumbnails and source files
1. Select the thumbnails that need relinking.
2. From the Thumbnail menu, choose "Relink."
3. Select a drive and/or folder where the source files are located. (Before moving an album and its source file to 

another drive, select Album drive for the program to automatically search for the source file in the new location.)
4. Click OK to start relinking selected thumbnails to their source files.

    Preparing CD-ROMs for distribution
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Checking links between thumbnails and source files
Automatically
1. Check the Check links to source files option in the Preferences: Album dialog box. 
2. Resize the album window, scroll, or sort through the album to initialize automatic checking. 

Note: Checking this option slows down processing time as you wait for Album to finish checking. Clear until automatic
updating is necessary.
Using the Check command
1. From the Album menu, choose "Check." Album displays the lists of missing and modified files
2. Click on the tab for the type of files to act on.

Note: The access mode for the active album has to be set to Read/Write before you can use the Check command. 
You can set this mode by choosing "Sharing" in the Album menu.

    Sharing an album
    Working with thumbnails Procedures Contents
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Changing a thumbnail
From the source file:
1. Select the thumbnail with representation to change.
2. From the Thumbnail menu, choose "Update: Source File" to change the thumbnail representation with the source 

file's program icon. 

Note: Album displays a "No Icon" thumbnail if an inserted file's file extension is not associated with an application or 
the application's icon is unavailable or unreadable.

From the Clipboard:
1. Double-click on the thumbnail to open the associated application and the source file.
2. Click on the maximize button for the application to fill the screen.
3. Hold down the Alt key and press the Print Screen key to capture the screen to the Windows clipboard.
4. Close the application and return to Album.
5. Select the thumbnail of the source file.
6. From the Thumbnail menu, choose "Update: From Clipboard" to change the thumbnail with the captured image 

from the Windows clipboard.
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Opening source files
1. Select the thumbnails to view in their associated application. 
2. From the Source menu, choose "Open" to open the files in their associated application.

Note: Double-clicking on a thumbnail opens the file in PhotoImpact Viewer. 

    Opening source files from the Tool panel
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Viewing multimedia files
1. Select the thumbnails with multimedia source files to view.
2. From the Source menu, choose "View" to run the following accordingly:

Image and Graphic files Display in the Viewer program.
Audio files Play in Microsoft's Media Player.
Video and Animation files Play in Microsoft's Media Player.
Application-linked files Display in the application that they are associated with.
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Converting file formats and data types
1. Select the thumbnail(s) with file formats to convert.
2. From the Source menu, choose "Convert."
3. Select the new file format and/or data type for converting.
4. Check the options for the converted file(s).
5. Click OK to start converting.
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Printing source files
1. Select the thumbnail(s) with source files to print.
2. From the Source menu, choose "Print."
3. Specify the number of copies to print.
4. Check "Scale to Fit the Page" to print as large as possible on the output page. Clear to print the image at a size 

determined by its resolution.
5. Select the desired centering option.
6. Click OK to start printing.
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Moving source files
1. Select the thumbnails representing the source files to move.
2. From the Source menu, choose "Move."
3. Select the drive and folder for the new location.
4. Click OK to start moving the source files.
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Copying source files
1. Select the thumbnails representing the source files to copy.
2. From the Source menu, choose "Copy."
3. Select the drive and folder for the files to copy.
4. Check "Insert Copied Files" to insert source files to an opened album. (When selected, choose the opened album 

to insert the files to.)
5. Click OK to start copying files.
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Deleting source files
1. Select the thumbnails representing the source files to delete from the hard disk.
2. From the Source menu, choose "Delete."
3. Album prompts you to confirm your decision. Click Yes to continue or No to cancel.

Note: Remember that the action is performed not only on the thumbnail but also on the actual file. 
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Renaming source files
1. Select the thumbnail representing the source file to rename.
2. From the Source menu, choose "Rename."
3. Enter the new name in the To entry box. 
4. Click OK to start renaming the file.
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Changing file attributes
1. Select the thumbnails with file attributes to change.
2. From the Source menu, choose "Properties."
3. Check or clear the boxes of the attributes to change. Click Apply to perform changes.
4. Click Prev or Next to go to the other selected thumbnails to change.
5. Click OK when done changing all the selected thumbnails.
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Changing file association
1. Select a thumbnail representing the file extension to associate with a program.
2. From the Source menu, choose "Associate."
3. Based on the selected thumbnails' file extension, select the program to associate from the Associate With Program

list.
4. Click OK to associate all the thumbnails with the specified file extension to the selected application program.

Note: To remove an association of a file, choose None from the Associate With Program list.
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Creating a slide show
1. Select the thumbnails of image, graphic, video, or animation files to display. If no selection has been made, all 

qualified files associated with thumbnails are displayed. (Slide shows do not play application-linked files.)
2. From the View menu, choose "Slide Show." Click Load to retrieve existing slide show files or define your own.
3. Select the transition effect to apply. (If "Synchronize With Audio Files" is selected, the program uses the time 

specified in the Delay option as a pause between each audio file.)
4. Check the boxes of the other display options to use during the presentation. (For more information about the 

remaining options, see the Slide Show dialog box Help.)
5. Click the Text & Color tab to append information to the files in the slide show and control the background color of 

the presentation.
6. Specify the location and alignment where you want the appended information to appear in the slide show.
7. Click on the Text color box to select the text color to use for the appended information.
8. Click on the Background color box to select the background color to use.
9. Click Font to select the text font to use for the appended information.
10. Click on the Music tab to add background music to the presentation using MIDI and/or sound files (WAV). (When 

playing only one background music, check Repeat continuously so that the file doesn't stop while the presentation 
continues.)

11. Click Play to start the presentation.

    Slide Show dialog box
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Using the scroll bar
Locate the scroll bar on the right side of the album.

Click the scroll direction button to move the view up or down a single line.
Click in the scroll bar to move the view by a page.
Drag the slider up or down to quickly move to a new location.

    Other ways of scrolling an album
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Using the Auto Scroll dial
1. Locate the Auto Scroll dial at the top of the Tool panel.
2. Click on the red dot and while holding the mouse key, turn the dial clockwise to scroll down, or counter clockwise 

to scroll up.
3. Release the mouse to stop scrolling.

    Other ways of scrolling an album
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Using the Auto Scroll command
1. From the View menu, choose "Auto Scroll."
2. Enter the delay time to wait before each scroll.
3. Click OK to start.
4. Press the space bar to pause/continue scrolling.
5. Press Esc to quit scrolling.

    Other ways of scrolling an album
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Locating a specific thumbnail
1. From the View menu, choose "Scroll to."
2. Select the specific thumbnail from the thumbnails list or enter the thumbnail's index number to locate.
3. Click OK to go to the specified thumbnail. 

Note: Double-clicking on the filename from the list also locates the thumbnail.

    Other ways of scrolling an album
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Adding programs

1. Click  in the Tool panel.
2. From the Tool Panel menu, choose "New."
3. Select the Program Group option and enter the program group name.
4. Select the Program Icon option and enter the description, location of the program, and working folder. Click 
Browse to search for other programs.
5. Click New to add to the Tool panel.
6. Click Close when done adding.

Note: You can also add programs by dragging execution files from Windows Explorer or File Manager to the Tool 
panel.

    Customizing the Tool panel Procedures Contents 



Changing properties of a program

1. Click  in the Tool panel.
2. From the Tool Panel menu, choose "Properties."
3. Select Program Group to edit program group name and enter the new name.
4. Select Program Icon to edit existing programs in the current program group.
5. From the Icon drop-down list, select the program to edit.
6. Click OK when done changing.
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Removing programs and program groups

1. Click  in the Tool panel.
2. From the Tool Panel menu, choose "Delete."
3. Select Delete Current Program Group to remove the currently selected program group and its program icons
from the Tool panel.
4. Select Delete Program icon From Current Group and enter the program icon name or select from the Icon 
drop-down list for deletion.
5. Click OK to remove the selected program group or program icon.
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Repositioning the Tool panel

1. Click  in the Tool panel or right click anywhere on the Tool panel.
2. From the Tool Panel menu, choose "Configure" or from the pop-up menu select the location for the Tool 
panel.
3. When Configure menu is chosen, select the location and click OK to move the Tool panel.
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Displaying a program group

1. Click  in the Tool panel.
2. Select the program group from the Program group list.
3. Click on the selected program group to display the programs belonging to the group.
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Defining album fields
1. From the Album menu, choose "Properties."
2. In the Properties dialog box, click the Fields tab to display existing album fields.
3. Enter the Field name to add, change, or remove.
4. Select the Field type for the specified Field name and click Add/Change/Remove.
5. Click OK apply the changes.

Note: The default fields' type cannot be modified.
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Performing a search
1. Open the album(s) to perform the search on.
2. For a simple search, use the Search toolbar. For a complex and more detailed search, choose "Search" from the 

Thumbnail menu.
3. Select the query you wish to search on from the Search Type drop-down list.
4. Select the Search Operator to determine the relationship of the entered data for query and the defined criteria.
5. Enter the data for query in the Search criteria entry box. If the data entry consists of more than one word, enclose 

it with the defined delimiter.
6. Check the operators and match options to serve as the criteria for the search. For a more specific criteria 

definition, click Edit criteria.
7. Select the search options and action to take after searching is completed. Check "Search all albums in the 

workspace except minimized" to match with all the thumbnails in all the opened albums (except minimized) in the 
workspace. Check "Add search result to current view" to combine the current found set of thumbnails to the found 
set of thumbnails of the next search operation.

8. Click Add to include a newly defined search criteria in the Search criteria list.
9. For additional criteria, repeat steps 3-8.
10.To change an existing search criteria, click on the criteria from the Search criteria list and follow steps 3-8. Click 

Change to replace the selected criteria to change in the list.
11.To delete a search criteria from the list, select the criteria delete from the Search criteria list and click Remove.
12.Click OK to start the search.

Note: Checking Search Entire Tab matches the search criteria with the thumbnails in the currently selected tab.
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Assigning marks
1. From the Marks list, select the mark(s) to assign. (Use the Shift with the mouse to select a range or the Ctrl key 

with the mouse to select individual ones.)

2. Click  and choose "Assign Selected" or click 
 to initialize assigning marks.

3. Click on the thumbnails to assign the selected marks. Clicking on a thumbnail already having the selected 
mark erases the similar mark.
4. Click  again to stop assigning marks.

    Editing and defining marks
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Editing and defining marks
1. Click  and choose "Edit" or double-click on the mark names from the Marks list to open the Edit marks dialog 

box.
2. From the Marks list, select an existing mark to edit or select an empty mark to add a new mark.
3. To use existing marks from other opened albums, select the album from the Adopt Marks From Album drop-
down list.
4. Click OK when done editing and defining marks.

    Assigning marks
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Loading and saving marks
1. Select the thumbnail(s) with marks to load or save.

2. Click  on the Mark panel and choose "Load" or "Save."
3. Select the folder for loading or saving.
4. Select the file format    *.MRK file extension.
5. Select/enter the filename for the mark file to load/save. 
6. Select whether to merge with or replace original marks for loading.
7. Click Open/Save when done loading or saving marks.

Note:  When loading, Album matches the incoming mark names of the selected thumbnail with the current marks list. 
If a mark letter is already assigned to another mark name, the program prompts you to select a new letter or cancel 
the process.
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Adding programs to the Tool panel
1. With Windows Explorer or File Manager open and displayed side-by-side with Album, select the execution files 

(*.exe) to add to the Tool panel. (Use the Shift key with the mouse to select a range of files or the Ctrl key with the 
mouse to select individual ones.)

2. From Windows Explorer or File Manager, drag the selected files and drop them onto the Tool panel.

    Dragging-and-Dropping Procedures Contents 



Opening album files into the workspace
1. With Windows Explorer or File Manager open and displayed side-by-side with Album, select the album files (*.ab3 

or *.abm) to open in the workspace. (The Album program only allows you to open two albums at a time in the 
workspace. To open more than one file, press the Ctrl key while selecting files.)

2. Drag and drop the selected files onto an empty part of the Album workspace.

    Opening an album
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Inserting thumbnails into an album
1. With Windows Explorer or File Manager open and displayed side-by-side with Album, select the files of the 

thumbnails to insert into the album. (Use the Shift key with the mouse to select a range of files or the Ctrl key with 
the mouse to select individual ones.)

2. Drag and drop the selected files in the open album. (The Album program only allows you to insert 100 thumbnails 
per album.)

    Other ways of inserting thumbnails
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Copying/Moving files between albums
1. With the albums to work on displayed side-by-side, select the thumbnails to move or copy to another album. (Use 

the Shift key with the mouse to select a range of thumbnails or the Ctrl key with the mouse to select individual 
ones.)

2. To move the selected thumbnails, drag the thumbnails and drop them into the target album.
3. To copy, hold the Ctrl key down while dragging and dropping the selected thumbnails into the target album.
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Embedding or linking files in other applications
1. Select the thumbnail to embed or link in a container application.
2. Drag-and-drop it with the Ctrl and Shift keys to link or the Ctrl key to embed the thumbnail in another application.

    Editing linked or embedded objects
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Embedding or linking thumbnails from an album
1. Open the album containing the thumbnail(s) to link or embed and select the thumbnail(s).
2. From the Edit menu, choose "Copy:Thumbnail."
3. Switch to the container program to link or embed.
4. From the container program, choose "Paste", "Paste Special", or "Paste Link" to embed or link the selected 

thumbnail(s).

Note: Depending on the container program, select "Ulead Album Thumbnail Object" from the As list box and click 
Paste Link.

    Editing linked or embedded objects
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Inserting files from a TWAIN device
1. From the File menu, choose "Acquire To" or click  in the standard toolbar.
2. Choose where to send the acquired images from the Acquire To submenu.
3. When  File & Album is selected, follow steps 4-7. If 

 Printer is selected, follow steps 8-10.
4. Select the drive and folder to save the new file.
5. Enter the filename for the image(s) to acquire. For multiple images, make the last character of the filename a
number to automatically add one (or two when selected) to the filename with each input.
6. Check "Increase file number by two" when scanning both sides and use an auto feed scanner to keep the file 

order identical to your page order.
7. Click Save.
8. Specify the number of copies to print.
9. Check "Scale to fit the page" to print the file as large as possible while maintaining the ratio.
10.Select the desired position on the page for the image(s) to acquire and click OK.
Note: Be sure to select the TWAIN device to input before using this command.

    Other ways of inserting thumbnails
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Selecting the TWAIN device
1. From the File menu, choose "Select Source."
2. Select the device to use from the data source drop down list.
3. Click OK to set the selected device as default.

Note: The data source list displays the different types of TWAIN devices. If your device is not listed, please install the 
driver of the scanner.



Managing the Album program
Preferences specific to Album:
1. From the File menu, choose "Preferences," then "Album." Double clicking on the status bar opens the same dialog

box.
2. Click the General tab to select the appearance and behavior for the selected album in the workspace.
3. Clear "Checking links to source files" until updating is necessary.
4. Click OLE Representation to define the behavior of files as OLE object in the container (another application) 

document.
5. Click Font to define the typeface to use for the selected album.
6. Click OK when done defining Album's characteristics.
Preferences specific to your system:
1. From the File menu, choose "Preferences," then "General."
2. Click the Memory tab to define memory management.
3. Click the Display tab to define how to display your graphics.
4. Click the Photo CD tab to define the data type and resolution for viewing PCD images.
5. Click OK when done defining preferences of your system.

    General Procedures Contents
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Resizing thumbnails
1. On the Status bar, click on Change thumbnail display size command. From the drop down list, select the desired 

size.
2. For more size options, choose "Thumbnail size" from the View menu.
3. Click on the desired size to change the size of the thumbnail. 

Note: To retain the newly selected thumbnail size every time you open this album, change the size using the View 
Menu: Thumbnail size or the Album Menu: Properties command.

    Why resize thumbnails?
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Controlling the Album workspace
To make other running applications visible on the screen, choose "Compact Mode" from the View menu or 

click 
 at the left most part of the Status bar .

To display all the menu commands and the different ways to position the album panel, click 
 at the left most part of the Status bar.

To display other running application along side with the active album, click 
 and choose "Tile With". Select the application to tile with Album. (This is most useful when performing drag-and-

drop operations.)
To go back to the previous screen display, click 

 and choose "Switch to Normal Mode".
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Choosing helpful tools
Using the mouse:
1. Right click on any of the toolbars, Tool panel, or status bar.
2. Highlight the one to display.
3. A check mark to the left of the list item means it's already selected and displayed in the workspace. Highlighting or 

selecting a marked item hides/deselects it.
Using the View menu:
1. From the View menu, choose "Toolbars & Panels."
2. Check the options to display and click OK to display the selected toolbars and panels.
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Moving an album to another location
1. Select the album to move.
2. From the Album menu, choose "Move."
3. Specify the drive and folder for the new location.
4. Click OK to move the selected album to the specified location.

    Managing the active album Procedures Contents



Copying an album
1. Select the album to copy.
2. From the Album menu, choose "Copy."
3. Specify the drive and folder for the copied album.
4. Click OK to copy the selected album to the specified location.

    Managing the active album Procedures Contents



Renaming an album
1. Select the album to rename.
2. From the Album menu, choose "Rename."
3. Enter the new name for the album.
4. Click OK to change the name of the selected album.

    Managing the active album Procedures Contents



Backing up an album
1. Select the album you want to backup.
2. From the Album menu, choose "Backup."
3. Select the drive and folder for the album's backup. (All the original files in the selected folder will be removed first 

and then replaced with the backups.)
4. Check "Backup selected files only" if you want to backup only the selected thumbnails.
5. Check "Compress files" to minimize file size requirement.
6. Click OK to create the backup.

Note: For maximum compression, convert all image files in an album to a ZLIB format. This is a lossy compression 
scheme producing a quality that may not be as good as the original.

    Managing the active album Procedures Contents



Restoring an album
1. From the Album menu, choose "Restore."
2. Locate the folder and drive containing the album and associated files to restore.
3. In the Restore To option, check "Original subfolder" to overwrite all existing files with the same filename as the files

to be restored or check "Another subfolder" to avoid replacing existing files with the same filename as the files to 
be restored.

4. Click OK to restore the album and associated files to their specified subfolders, and the album to appear in the 
Album workspace.

Note: To restore an album with the same filename as an existing one, restore it to a different folder and then rename, 
remove, or delete the other to open the restored file in Album.

    Managing the active album Procedures Contents



Sharing an album
1. From the Album menu, choose "Sharing."
2. Check the option for local access in the Active album. Read-only mode does not allow the current user to make 

any changes on the current album.
3. Check the access mode option for other users in the Sharing mode. When set to "Do not share mode," you can 

change the properties of thumbnails and other users have no access to the album. (If you want others to only view 
and not be able to make any changes on the album, select Share as read-only.)

4. Click OK when done setting.

Note: If others are already using the album, you cannot change the settings.

    Managing the active album Procedures Contents



Refreshing an album
To update an album opened at the same time by more than one user, choose "Refresh" from the File menu.

Note: The Refresh command is only available when you select "Share as read/write" in the Sharing command from 
the Album menu.

    Why refresh your album?
    Managing the active album Procedures Contents



Sending an album
1. With an MS Mail compatible driver installed, choose "Send" from the File menu.
2. Select the album file and/or source files to send in the Send Files tab. 
3. Check "Send files as separate mails" when sending large files over the network.
4. Check "Include field data in message text" to append the album's field data in the mail.
5. If you wish to send additional message with your mail, click the Message Text tab.
6. Enter the subject and message.
7. Click OK to start sending the message.

Note: When "Send files as separate mails" is selected, the subject and message appear in all the mails.

    Managing the active album Procedures Contents



Changing an album's properties
1. From the Album menu, choose "Properties."
2. If the album is password protected, enter the password when prompted.
3. Click on the General tab to change the album's title and description, size and data type of thumbnails, and 

compression.
4. Click on the Fields tab to add, remove, or change the names and/or field types.
5. Click on the Advanced tab to assign a password or set folder monitoring for any changes in the source files.
6. Click on the More tab to display more detailed information about the album.
7. Click OK to apply the newly defined characteristics, click Restore to return to the last saved version of the defined 

characteristics and continue editing, or click Cancel to stop changing album properties.

Note:  To modify the properties of an album, the album must be in Read/Write mode and cannot be shared.    
Read/Write access and sharing are controlled by the Sharing command in the Album menu.

    Managing the active album Procedures Contents



    Entering field data
    Importing field data
    Exporting field data



Closing an album
1. Select the album to close.
2. From the File menu, choose "Close" or click  in the title bar.

    General Procedures Contents
    Managing the active album Procedures Contents



Using Scan Play
1. Select the thumbnails representing audio, video, and/or animation files to scan or play.
2. From the View menu, choose "Scan Play." 
3. Specify the scan/play period for the selected files. To scan/play the files completely, select Play All. Otherwise, 

select Play only first  XX seconds and specify the number of seconds to play. 

4. To pause or continue playing the files, click    .
5 To skip the current file, click Skip.
6. When an error occurs during the scan/play, click OK to start the next file or Cancel to stop the scan playing 
of selected thumbnails. (To skip the confirmation message, clear "Always confirm" to automatically go to the next 
multimedia file.)

Note: To put a mark for identification on a thumbnail in view, select the mark to use and click Mark.

    Viewing Procedures Contents



Displaying two panes in the workspace
1. Double click on the pane splitter located in the scroll bar.
2. From the View menu, choose "Mode."
3. The submenu displays two sets of display modes. From the second set of display mode, select the desired mode.

Note: Selecting the Data Entry mode allows you to enter/edit field data of the displayed thumbnail.

    Working with field data
    Viewing Procedures Contents



Using tabs
1. From the View menu, choose "Show Tabs" or double-click on the folder splitter located in the top most part of the 

scroll bar.
2. Click on the folder icon to select the folder of thumbnails to display.
3. From the View menu, choose "Hide Tabs" when done working with the folders.

Note: To define/edit the folder tab width, choose "Preferences/PhotoImpact Album" in the File menu.

    Moving thumbnails between tabs
    Viewing Procedures Contents



Creating a folder
1. From the Source menu, choose "Create Folder."
2. Specify the filename and location for the new folder.
3. Click OK to create the defined folder.

    Managing source files Procedures Contents



Removing a folder
1. From the Source menu, choose "Remove Folder."
2. Specify the folder to delete or click Browse to locate the folder you want to remove.
3. Click OK and then Yes in the confirmation message to delete the selected folder from the hard disk.

    Managing source files Procedures Contents



Moving thumbnails between tabs
1. Select the thumbnails to move to another tab.
2. Drag the thumbnails to the desired tab. This automatically changes the list value of the thumbnails.

    Working with thumbnails Procedures Contents 
    Dragging-and-Dropping Procedures Contents 



Displaying another program with Album
1. From the File menu, choose "Compact mode" or click .
2. Click  to display the options on where to position the album panel.
3. Click  again and choose "Tile With." 
4. Select the program application to display with Album on the workscreen.

Note: This feature is very useful when performing drag-and-drop operations.

    Viewing Procedures Contents



Entering field data
1. From the View menu, choose "Mode:Data Entry" or click .
2. Select the field to enter data and type.
3. Click on the scroll buttons to move through all the thumbnails or the selected thumbnails in the album.
4. Right click on an edit work area to display the commands for entering field data. 
5. Double click on a keyword or list field type entry section to select, delete, or add values from/to the current 
list.

    Field restrictions
    Displaying two panes in the workspace
    Working with thumbnails Procedures Contents 



Importing field data
1. From the Thumbnail menu, choose "Import:From File."
2. Locate and select the database file to import.
3. Select "Match field values with album's field" and "Field names as first record."
4. Check the fields in the Fields in Album list that correspond to those in the input file.
5. Reposition the fields in the Fields in album list in the same order as the Fields in input file by dragging the fields up

or down.
6. Click OK when done matching to start importing.

Note: If there are more records in the input file than the thumbnails in the album, the extra records are discarded. If 
fewer, the fields are left empty in the extra thumbnails.

    Field restrictions
    Working with thumbnails Procedures Contents 



Exporting field data
1. Select the thumbnails with fields to export or select none/all to export data of all the thumbnails.
2. From the Thumbnail menu, choose "Export." 
3. Specify the file name and format for exporting.
4. Click on the Fields tab to select the fields to export. Drag-and-drop the selections to change the order that they 

appear in the file.
5. Select "Store field names in first row" to save the exported fields' names in the first row of the file.

    Working with thumbnails Procedures Contents 



Using the CD Browser program
1. Open the PhotoImpact CD Browser program.
2. From the File menu, choose "Insert Thumbnails into Album."
3. Select an album to insert the thumbnails into or click New album to create a new one.
4. Click OK to start inserting thumbnails.

    Working with thumbnails Procedures Contents 



Adding annotations
1. Select the thumbnail(s) to add an annotation file to.
2. From the Thumbnail menu, choose "Annotation: Add."
3. Select the file type to attach.
4. Enter or select the sound or multimedia file to attach to the selected thumbnail(s).
5. Click Open to annotate the selected file to the thumbnail(s).

Note: Thumbnails marked with a red music note on its upper right corner have sound or multimedia files attached to 
them. To play only the annotation file, double click on the red music note.

    Working with thumbnails Procedures Contents 



Changing annotations
1. Select the thumbnail(s) with annotation to change.
2. From the Thumbnail menu, choose "Annotation: Change."
3. Select the file type to attach.
4. Enter or select the sound or multimedia file to replace the current annotation file.
5. Click Open to attach the new annotation file to the thumbnail(s).

    Working with thumbnails Procedures Contents 



Removing annotations
1. Select the thumbnail(s) with annotations to remove.
2. From the Thumbnail menu, choose "Annotation: Remove."
3. Click Yes to continue deleting the annotation from the thumbnail, No to cancel.

Note: Removing annotations from the thumbnails does not delete the annotation file from the disk. To delete the 
actual annotation file, choose "Delete" from the Source menu.

    Working with thumbnails Procedures Contents 



Playing annotations
To play only the annotation file, double click on the red music note of a thumbnail located at its upper right 

corner.
To play an annotation file right after opening a thumbnail's source file, check "Play annotation file after 

viewing thumbnails" in the File menu/Preferences:Album dialog box.

    Working with thumbnails Procedures Contents 



    Adding annotations
    Changing annotations
    Removing annotations
    Playing annotations



Opening source files from the Tool panel
1. Select the thumbnails with source files to open.
2. Drag the selected thumbnails to the Tool panel and drop them on top of the desired program icon to open the 

source file in the selected program.

Note: Thumbnails dragged and dropped on the Tool panel must be compatible with the selected program icon. You 
can drag and drop multiple thumbnails on any of the PhotoImpact program icons with the exception of CD Browser 
and Explorer.

    Dragging-and-Dropping Procedures Contents 



Editing linked or embedded objects
1. Right click on an object in a container program document.
2. To open an object for a more detailed look or editing, choose Ulead Album Thumbnail Link: View. (PhotoImpact 

Viewer opens image and graphics files and Windows Media Player opens sound, animation, and video files.)
3. To select another thumbnail to replace an embedded object, choose Ulead Album Thumbnail Object: Reselect to 

go back to the Album program.
4. Select another thumbnail for replacement.
5. From Album's File menu, choose Update and select the container document from the submenu.
6. Return to the container program document to check the newly selected thumbnail.

    Embedding or linking files in other applications
    Embedding or linking files from an album



Storing objects from an application into an album
Select the object in the container program and then drag and drop it into an album. The program creates a new tab 
for storing linked or embedded objects.

    Dragging-and-Dropping Procedures Contents 



Why calibrate my display?
Calibrating your display ensures the most accurate image 
reproduction. Each monitor is a little different, and 
temperature and environment can also play a role in 
determining how color appears. The Ulead calibration 
process takes a dithered black-and-white image and 
compares it with the color it is trying to approximate. Since 
black and white represent the extremes for your monitor, 
and the compared color is a set value, you can adjust your 
monitor to produce the best results.

Note: Calibrating your monitor works great for Ulead 
programs, but will not affect how images appear in other 
programs.

Calibrating the display
1. From the File menu, choose "Preferences."
2. Click the Display tab.
3. Check Monitor Gamma.
4. Raise or lower the Gamma Value until the gray box looks something like this:

Note: Increase your distance from the monitor to about six feet, (2 m), to make the pattern in the upper rectangle less
apparent.
5.  Click OK.

Why calibrate my display?
    General Procedures Contents



Using PhotoImpact Explorer to view files
To quickly view the contents of any image or graphics file, choose "PhotoImpact Photo Explorer" from the Switch 
menu. Image and graphics files of each folder are displayed as small thumbnails for you to view quickly the contents 
of your system.

    Viewing Procedures Contents



Preparing CD-ROMs for distribution
To link source files to the drive where the album file resides, make album search the right source location, and be 
able to distribute albums on a CD-ROM, do the following:
1. Make sure all the files you want to distribute are in their appropriate folders.
2. From the Thumbnail menu, choose "Relink."
3. Select the Album drive option and click OK to check if any files are not currently on the same drive as the album 

file. (If an error message appears asking if you want to link the file, click Yes to continue distributing the file, NO if 
not.)

Note: For CD-ROM distribution, copy all your files to distribute, both source and album, to the CD-ROM. Be sure to 
keep the same folder structure as you copy the files to enable your album to find the source files.

    Relinking thumbnails and source files
    Working with thumbnails Procedures Contents 



New    
Creates a new album. To define the characteristics of a 
template, click Properties.

(Hot Key -- Ctrl+N)

    Creating a new album
    Why use a template?

Open    
Allows you to open an existing album into the workspace. 
(You can only open two albums at a time.)
(Hot Key -- Ctrl+O)

    Opening an album

Close
Closes the active album without exiting the program.
(Hot Key -- Ctrl+W)

    Closing an album

Shelf
Allows you to move albums between the workspace and the 
shelf. A dialog box displays the titles of albums currently in 
the workspace and those on the shelf. 

    Using the album's shelf
    Why place albums on the shelf?

Batch Manager
Allows you to apply a command to multiple albums in a 
single operation. A dialog box displays the list of commands 
to select from and all the opened albums in the workspace.

    Using the Batch Manager

Acquire to    
Allows you to input and send images to one of the following 
locations:

File & Album Saves the acquired image to file and 
inserts its thumbnail into an album.

Fax in B & W Sends the acquired image to a black
and white fax.

Fax in Color Sends the acquired image to a color 
fax.

Printer Sends the acquired image to the default 
printer.

Mail Sends the acquired image to e-Mail.

Note: Whenever you acquire, a dialog box appears allowing
you to specify where to save after input.



    Inserting files from a TWAIN device
    Selecting the TWAIN device

Select Source
Displays a list of the devices currently installed in your 
computer that can be used to acquire an image. Select the 
source you want to act as the default device.

    Selecting the TWAIN device

Page Setup
Allows you to set the page margins, headers, and footers to 
use when printing an album. To change any print settings, 
click Printer.

Print    
Prints the contents of an album. A dialog box appears 
allowing you to specify the range of thumbnails and number 
of copies to print. To change any printer information, click 
Properties.

(Hot Key -- Ctrl+P)

    Printing an album

Print Preview    
Displays an album as it would appear on the output page 
before you send it to the printer. This offers Print, Next 
Page, Prev Page, Two Page, Zoom In, Zoom Out, and 
Close commands. These buttons help you visualize your 
album's appearance on paper. To change any printer 
information, click Print.

Send
Allows you to send albums to other computers connected to 
your PC. A dialog box offers choices for determining where 
to the send files and whether or not to attach messages. 
(This command is only available if you have Microsoft 
Network Exchange installed in your computer.)

    Sending an album

Preferences
Opens a submenu for setting the basic behavior and 
appearance of the Album program.

PhotoImpact Album Defines the preferences 
specific to Album. This command opens a dialog box for the 
general characteristics of the album, display format, and 
font. 

(Hot Key -- F6)



General Defines the preferences specific to your 
system. This command opens a dialog box for Memory, 
Display, and Photo CD characteristics.

    Managing Album

Exit
Ends the Album program.

(Hot Key -- Ctrl+Q)

    Exiting Album

Recently opened files
Displays a list of the files recently removed from the 
workspace. Clicking on a file in this list opens it in the 
workspace. (You can control the number of filenames to 
display with the Preferences: Album command in the File 
menu.

Undo
Reverses the effect of the last applied command.

(Hot Key -- Ctrl+Z)

Cut    
Removes selected thumbnails from an album and transfers 
them onto the clipboard.

(Hot Key -- Ctrl+X)

    Moving thumbnails from one location to another
    Moving thumbnails onto the clipboard

Copy
Duplicates data from selected thumbnails and places the 
data onto the clipboard. A submenu offers the following 
commands:

Thumbnail Copies the selected thumbnails onto 
the clipboard. 

(Hot Key -- Ctrl+C)
Field Data Copies the selected thumbnails' field 

data onto the clipboard.
Filename Copies the selected thumbnails' 

filenames onto the clipboard.

    Copying thumbnails

Paste    
Allows you to place a thumbnail, field data, or filenames that
was previously cut and placed onto the clipboard into an 
album. Copied thumbnail and field data can also be pasted 



into an album.

Note: You cannot paste copied filenames into an album.

(Hot Key -- Ctrl+V)

    Moving thumbnails from one location to another
    Copying thumbnails

Clear
Deletes selected thumbnails from an album. (This does not 
delete the actual files from your system.)
(Hot Key -- Del)

    Deleting thumbnails from an album

Select All
Selects all thumbnails in an album.

(Hot Key -- Ctrl+A)

    Selecting thumbnails

Select None
Deselects all selected thumbnails in an album. 

Select Invert
Selects all unselected thumbnails and deselects all 
previously selected thumbnails in an album. 

    Selecting thumbnails
    Why choose Select Invert?

Make Album
Creates a new album containing copies of any selected 
thumbnails in the current album.

    An album from an album
    Why create an album from an already existing album?

All/Selected/Not Selected
Allows you to choose which thumbnails to display in the 
workspace.

All/View All Displays all the thumbnails in the 
workspace. 

Selected Displays only the selected thumbnails in 
the workspace.

Not Selected Displays only the thumbnails in the 
album that are not currently selected.



Scroll to/Go to
Allows you to go to a specific thumbnail in an album.

(Hot Key -- Ctrl+D)

    Locating a specific thumbnail

Auto Scroll
Scrolls through all the thumbnails in an album.

    Using the auto scroll command

Scan Play
Sequentially plays the selected thumbnails of all multimedia 
files in an album. It also allows you to mark thumbnails while
viewing. (When Album comes across any non-multimedia 
files, it stops and displays an error message.)

    Using Scan Play

Slide Show    
Displays selected files from an album in a slide show. A 
dialog box offers choices on how the slide show is 
presented, including transition effects, sound tracks, 
captions, and annotations.

    Creating a slide show

Mode
Determines how Album displays information in the 
workspace. A submenu offers the following view mode 
commands:

Thumbnail Displays the thumbnails of files in an 
album. 

Attribute Displays the file attributes files in an 
album.

Filename Displays the filenames along with other 
information of files in an album.

Data Entry Displays the data fields of files in an 
album. (Use this mode to enter field data.)

Layout Opens a dialog box to specify which 
attributes to display in the different view modes.
Note: A bullet to the left of the mode indicates the current 
mode.

    Getting an idea on contents of files

Lower pane's view mode
Allows you to choose the view mode for the lower pane 
when in a two-pane display type.

Thumbnail Displays the thumbnails of files in an 
album.

Attribute Displays the file attributes of files in an 



album.
Filename Displays the filenames along with other 

information of files in an album.
Data Entry Displays the data fields of files in an 

album.
Note: A bullet to the left of the mode indicates the current 
mode.

    Displaying two panes in the workspace

Tabs by
Allows you to display thumbnails by any tabs defined in an 
album. A submenu opens with these commands:

Category Displays tabs corresponding to the 
values of the field names with List as field type.

Media Type Displays tabs corresponding to media 
type of each source file.

    Exploring your album's tabs

Thumbnail Size
Controls the size of thumbnails in an album. A submenu 
displays the size options. A bullet to the left of the size 
option indicates the current size.
Note: This only changes the size of thumbnails on the 
current view. If you close an album, thumbnails return to 
their default size. To change their default size, choose 
"Properties: General" from the Album menu.

    Resizing thumbnails
    Why resize the thumbnails?

Size options
Displays the thumbnail size options measured in pixels. 
Note: This only changes the size of the thumbnails on the 
current view. If you close an album, the thumbnails return to 
their default size. To change their default size, choose 
"Properties: General" from the Album menu.

    Resizing thumbnails

Show/Hide Tabs
Shows or hides any tabs in an album.

    Exploring the album's tabs

Normal Mode
Displays an album in its standard workspace operation 
mode.

    Controlling Album's workscreen



Compact Mode
Reduces the size of the Album program window and hides 
menus to enable tiling with other applications.

    Controlling Album's workscreen

System Properties
Displays information about your PC and the available 
system resources.

    System Properties

Toolbars & Panels
Allows you to choose the tools to show in the workspace for 
easy access to various commands and help you work more 
efficiently. Here you can turn ToolTips on or off, choose 
between small and large icons for the toolbars, and decide 
which toolbars and panels appear.

    Choosing helpful tools

Check
Verifies the links between an album's thumbnails and their 
source files. A dialog box shows a list of missing and 
modified files. You can reconnect broken links, remove 
thumbnails, or update the thumbnails of modified files.

    Checking links between thumbnails and source files
    Relinking thumbnails and source files

Move/Copy
Moves or copies an album's file to another folder without 
losing the links between the thumbnails and their source 
files.

    Moving the active album to another location
    Copying the active album

Delete
Deletes an album file from your hard disk.

    Deleting an album

Rename
Allows you to change the filename for an album without 
breaking any links between the thumbnails and their source 
files.

    Renaming an album

Backup



Saves an album and all its associated files to another 
location. A dialog box allows you to specify where to save 
the backup and whether or not to compress the backed-up 
files.

    Backing up an album

Restore
Retrieves a backed-up album and its associated files. A 
dialog box allows you to restore the backed-up albums to 
their original subfolder or to another subfolder.

    Restoring an album

Sharing
Allows you to control access to your albums when shared 
over a network. 

    Sharing an album

Refresh
Allows you to update the contents of an album when 
multiple copies are open on a network. 

(Hot Key -- F5)

    Refreshing an album
    Why refresh your album?

Properties
Allows you to edit the attributes and parameters of an 
album. 

    Changing album properties

Insert
Allows you to add new thumbnails to an album. A dialog box 
offers choices whether to insert individual files or all the files 
in a selected folder. (The Album program only allows you to 
insert 100 thumbnails per album.)

(Hot Key -- Ins)

    Files
    Folders

Search    
Searches an album for thumbnails that match the specified 
criteria in the Search dialog box. 

(Hot Key -- Ctrl+F)

    Logical Operators



    Performing a search

Search Entire Tab
Allows you to search for the target thumbnails in the 
currently selected tab.

    Performing a search

Add to Current View
Allows you to add the results of a search to the current view.
(This command is not available if "Search Entire Tab" is 
selected.)

Sort    
Arranges the thumbnails in an album according to conditions
specified in the Sort dialog box.

    Arranging the order of thumbnails

Save Sequence    
Renumbers thumbnails so that their sequence matches the 
current arrangement. The index number changes to reflect 
their new position.

    Arranging thumbnails' order

Import
Allows you to input information from another database 
format directly into an album. This opens a dialog box to 
define the data for input:

File Allows you to specify the database file to 
import.

Fields Displays the fields of the selected database 
file and the active album. 

Note: Only identically formatted fields can be matched 
together. Album supports several database formats including
dBASE IV files.

    Importing field data

Export
Allows you to save the selected database information from 
an album to an external file.

Note: Album supports Formatted Text Files (*.prn), Tab 
Delimited Text Files (*.txt), Comma Delimited Text Files 
(*.csv), and dBASE IV Files (*.dbf).

    Exporting field data

Update



Replaces selected thumbnail images with new ones. A 
submenu displays the following commands:

From Source File Generates thumbnails based on
source file data.

From Clipboard Generates thumbnails based on 
an image from the clipboard.

    Changing a thumbnail
    Why change thumbnails?

Relink
Locates and reestablishes links between the thumbnails and
their source files. 

    Relinking thumbnails and source files
    Checking links between thumbnails and source files

Open
Opens the file for the selected thumbnail in its associated 
application.

(Hot Key -- Enter)

    Opening source files

Convert
Creates a copy of the current thumbnail's source file in a 
different file format.

    Converting file formats and data types

Print
Prints the source files of selected thumbnails in an album.

    Printing source files

View
Runs Viewer and opens any image or graphic files of 
selected thumbnails.

    Viewing multimedia files

Move
Moves the source files of any selected thumbnails to a new 
folder without breaking the links between them.

    Moving files

Copy
Copies the source files of any selected thumbnails to a new 
folder. 



    Copying files

Delete
Permanently removes the source file of any selected 
thumbnail from its folder and removes the linked thumbnail.

    Deleting    files

Rename
Renames the source file of any selected thumbnail.

    Renaming files

Associate
Links the source file of any selected thumbnail to an 
application. (If the file extension of the linked source file is 
recognized by Album, file association is set automatically.)

    Changing file association

Create Folder
Creates a new folder on your hard disk.

    Creating a folder for the source files

Remove Folder
Removes the selected folder from your hard disk.

    Removing a folder of source files

Properties
Displays the source file attributes for the selected thumbnail.

(Hot Key -- Alt+Enter)

    Changing file attributes

Cascade
Arranges all open album windows in the workspace, from 
upper left to lower right.

(Hot Key -- Shift+F5)

Tile Horizontally/Vertically
Evenly distributes all opened albums in the workspace from 
left to right and top to bottom (Horizontally) or from top to 
bottom and left to right (Vertically).

(Tile Vertically Hot Key -- Shift+F4)



Arrange Icons
Arranges all minimized albums in the workspace into 
regularly spaced rows at the bottom of the workspace.

Currently opened files
Lists the names of all currently opened albums in the 
workspace. Clicking on a filename makes it the active 
album.

Ulead PhotoImpact Album Help
Starts the on-line help.

You can also access help topics by:
Clicking the help button and then clicking on the 

item of interest.
Placing the mouse over an item of interest and 

pressing F1.

About Ulead Products
Provides insight into the history, philosophy, and products of 
Ulead Systems.

About PhotoImpact Album
Provides copyright and other information about Album.

Switch
Opens a menu listing other Ulead programs for quick 
access. 

Why place albums on the shelf?
When working with a large number of albums, you may find 
that they clutter the workspace and make it harder to find 
those albums you want to work with. Placing excess albums 
onto the shelf not only reduces the number of albums 
occupying the workspace but also frees up system 
resources.

Why resize thumbnails?
Resizing thumbnails to smaller sizes allows you to view as 
many thumbnails as possible on the screen at one given 
time. Resizing to larger sizes helps you better view each 
thumbnail's file appearance.



Why refresh your album?
When an album is opened by more than one user at the 
same time, any changes made on the album by other users 
may not yet be reflected on your album. To update your 
album, choose "Refresh" from the Album menu.

Why select Write errors and journals to file?
When inserting a large number of thumbnails, any errors 
that occur will stop the insertion process. This may be 
undesirable if you are spending a lot of time inserting. If you 
select this option, any errors are saved to a text file and the 
insertion process continues. Then you can come back and 
find out where problems occurred later.

Put on Shelf
Allows you to move the currently selected album onto the 
shelf.

    Why place albums on the shelf?

Save    
Resets the current thumbnail sequence and updates the 
index numbers to reflect the new thumbnail order.

(Hot Key -- Ctrl+S)

Save As
Allows you to save an album with a new name and location.

(Hot Key -- F12)

Help    
Allows you to click on an item for help. To use , click on it 
and when the pointer changes to a question mark, click on 
the item you have a question on.

Annotated
Displays only the thumbnails with annotations.

Add
Annotates sound, MIDI, video, or animation files to a 
thumbnail. 



    Adding annotations

Remove
Removes no longer needed annotation on a thumbnail.

    Removing annotations

Why choose Select Invert?
This command is useful when you wish to act on all but a 
few thumbnails. For example, you can first select the 
thumbnails that you don't want and then choose "Select 
Invert". Now, all the selected ones will be deselected and the
ones you want will be selected.

Why use a template?
Templates are pre-defined albums tailored for specific tasks. 
Using templates is a way to get started right away and save 
time in building up the fields you need for a particular 
purpose. Of course, if the fields defined in a given template 
don't exactly fit your requirements, you can always edit, add 
or delete them later.

Why create an album from an existing album?
When you have inserted a folder of thumbnails, the files may
sometimes not be interrelated and you want to separate 
them. Select the thumbnails that should go together and 
choose "Make Album" from the Edit menu. A new album is 
created with related thumbnails.

Change
Allows you to change the currently annotated file of a 
thumbnail with a new one.

    Changing annotations

Replace Thumbnail
Replaces selected thumbnails with their annotations.

Annotation
Allows you to add an annotation file to a thumbnail. Once 
added, you can change or remove them. It can also replace 
thumbnails with their annotations.

    Working with annotations

Why change thumbnails?



A thumbnail represents a file in an album. It provides visual 
information on the contents of the file. A video file, for 
example, may be more helpful if you use a frame from the 
file that tells best about its contents. By capturing the image 
to the clipboard, you can use it to represent the video file in 
an album. In cases where the type of program application is 
more visually helpful, update from the source file.

Copy
Duplicates the current thumbnail, field data, or filename onto
the clipboard. A submenu offers the following commands:

Thumbnail Copies the current thumbnail onto the 
clipboard. 

(Hot Key -- Ctrl+C)
Field Data Copies the current thumbnail's field 

data onto the clipboard.
Filename Copies the current thumbnail's filename 

onto the clipboard.

Paste
Allows you to place the current thumbnail, field data, or 
filename that were previously cut and placed onto the 
clipboard into an album. Copied thumbnail and field data 
can also be pasted into an album.

Note: You cannot paste a copied filename into an album.

(Hot Key -- Ctrl+V)

Clear
Deletes the current thumbnail from an album. (This does not
delete the actual files from your system.)
(Hot Key -- Del)

Properties
Displays the source file attributes for the current thumbnail. 

(Hot Key -- Alt+Enter)

View
Runs Viewer and opens any image or graphic file of the 
current thumbnail.

Open
Opens the file of the current thumbnail in its associated 
application.



Move
Moves the source file of the current thumbnail to a new 
location without breaking the link between them.

Copy
Copies the source file of the current thumbnail to a new 
location. 

Delete
Permanently removes the source file of the current 
thumbnail from its location and removes the linked 
thumbnail.

Rename
Renames the source file of the current thumbnail.

Field Data 
Copies the current thumbnail's field data onto the clipboard.

On-line Registration
Opens Ulead Systems Registration Wizard which allows you
to register your products through our web page or the          e-
mail internet connection. Registering your software ensures 
periodic updates of all our products.



TIFF Save Options dialog box
Format Choose to save the file for use on an IBM PC- compatible or Apple Macintosh system.
Compression Choose a compression method to apply to the file.
Strip size Try the default setting of 8 first. If you need a smaller file, increasing the strip size may help.
Tile size If varying the strip size still does not produce adequate compression, try varying the tile size.
Horizontal differentiation If your image contains large solid-colored areas (not dithered), horizontal 

differentiation can improve the compression. If the image contains mostly random or widely dispersed colors, the 
advantage is minimal.

Include preview Saving a preview makes the file a little bigger but allows some programs to display the 
image without actually opening it.



IFF, PSD,TGA, & UFO Save Options dialog box
Choose Run Length Encoding (RLE) for a smaller file size. If you have problems, save it again without compression.



RAS Save Options dialog box
Compression Choose Run Length Encoding (RLE) for a smaller file size. If you have problems, save it 

again without compression.
Byte order Try Most Significant Byte (MSB) first.
Color order Try BGR first.



JPEG Save Options dialog box
Quality Lower quality results in smaller files at the cost of image quality. The default setting offers good 

compression without significantly affecting the image appearance.
Progressive compression Check to enable the file to open progressively. This also places preview 

information in the file which enables some programs to view the file without actually opening it.



EPS Save Options dialog box
Format The ASCII format is more widely accepted but results in a larger file size. Binary EPS files are about

half the size of the same ASCII files.
Save Preview Saving a preview makes the file a little bigger but allows some programs to display the image

without actually opening it.



BMP Save Options dialog box
Choose whether to save the file as an MS-Windows or OS/2 bitmap.



PNG Save Options dialog box
Interlace Check to allow images to open progressively when viewed on-line. This may increase file size.
Description Assign a brief description, key words, or other text message to store with the image.
Compression method Choose Compress more for the smallest possible file. Choose Compress faster to 

enable faster opening when viewed on-line.
Background color Click the color square to choose a color that appears as a background to the image.



GIF Save Options dialog box
Color table Displays the color palette of an image. Click on the color you wish to make transparent when 

the image is placed as an object.
Transparent color Displays the color that appears transparent when placed as an object into another 

image.
Save in Interlaced format Check to open the image progressively when viewed on-line. This may increase 

file size.



Browse dialog box
File name Define the search criteria for finding files. You may use the * and ? wildcards to find files with 

similar names.
Files found Select the desired file from the list showing all files matching the search criteria. (Use the Shift 

and Ctrl keys just like multiple files.)
Folders Select the folder to start the search from.
Drives Select the drive containing the folder you want to search.
Sort files Select the sorting order and whether to start from first to last (ascending), or last to first, 

(descending).
Scan Expand the search to include any folders inside the selected folder.
Delete Permanently remove selected files in the Found list from the hard disk.
Rename Change the name of selected files in the Found list from the hard disk.
Network Access shared folders on other connected computers running Windows.



Some file formats do not offer any save options. In this case, the Options button is disabled.



This button only appears if you are running in Windows for Workgroups or Windows 95. 



The benefit of choosing this option depends on the image. 



This is most useful for images you are preparing for the WWW or other on-line services. It enables viewers to see a 
representation of the image faster, thus allowing them to decide faster whether to wait to download the entire image 
for viewing. It is also useful if you wish to automatically see a preview thumbnail in the Open Image dialog boxes for 
Ulead and other programs that support preview information.



When using compression, larger strip sizes offer higher compression ratios. However, some programs may not be 
able to read TIF files with large strip sizes.





Welcome
Welcome
What is Album?
Reading this Help

Welcome to Album Help. In addition to this introduction, this 
document contains four sections to help you learn.

Using Album Offers instruction on completing single tasks. 

Reference Describes menu commands, the workspace, and
dialog boxes. It also has an advice section.

Imaging Essentials Presents valuable background 
information about computer graphics.

Contacting Ulead How to contact Ulead Systems when you
need advice or have comments.

Imaging Essentials
Overview
Computer graphics
Images
Color

This section contains information about graphics and 
computers, introducing the technology behind this product. 
Most of the topics in this section are longer than those in 
other parts of this help and are intended to help you better 
understand the concepts upon which Ulead programs are 
based.

File Menu



Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes 
Advice

The File menu contains these commands. Click below for 
more information.

 New  Select Source
 Open  Page Setup
 Close  Print Preview
 Save  Print
 Save As  Preferences
 Shelf  Recently opened files
 Acquire to  Exit

Click Menu commands on the left for help on other Album 
menus.

Edit Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes
Advice

The Edit menu contains these commands. Click below for 
more information.

 Undo  Select All
 Cut  Select None
 Copy  Select Invert
 Paste  Make Album
 Clear

Click Menu commands on the left for help on other Album 
menus.

View Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes
Advice

The View menu contains these commands. Click below for 
more information.

 All  Mode
 Selected  Tabs by
 Not Selected  Thumbnail Size
 Annotated  Show/Hide Tabs
 Scroll to  Normal Mode
 Auto Scroll  Compact Mode
 Scan Play  System Properties
 Slide Show  Toolbars & Panels

Click Menu commands on the left for help on other Album 
menus.

Album Menu
Workspace
Menu commands

The Album menu contains these commands. Click below for 
more information.



Right click Pop-up 
Menus

 Standard click Pop-
up Menus

Dialog boxes 
Advice

 Check  Backup
 Move  Restore
 Copy  Sharing
 Delete  Refresh
 Rename  Properties

Click Menu commands on the left for help on other Album 
menus.

Thumbnail Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes
Advice

The Thumbnail menu contains these commands. Click 
below for more information.

 Insert  Import
 Search  Export
 Search Entire Tab  Annotation
 Add to Current View  Update
 Sort  Relink 
 Save Sequence

Click Menu commands on the left for help on other Album 
menus.

Source Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes
Advice

The Source menu contains these commands. Click below 
for more information.

 Open     Delete
 Convert     Rename
 Print     Associate
 View     Create Folder
 Move     Remove Folder
 Copy     Properties

Click Menu commands on the left for help on other Album 
menus.

Window Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes
Advice

The Window menu contains these commands. Click below 
for more information.

 Cascade
 Tile Horizontally
 Tile Vertically 
 Arrange Icons
 Batch Manager
 Currently opened files

Click Menu commands on the left for help on other Album 
menus.



Help Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes
Advice

The Help menu contains these commands. Click below for 
more information.

 Ulead PhotoImpact Album Help Topics
 About Ulead Products
 About PhotoImpact Album

Click Menu commands on the left for help on other Album 
menus.

Switch Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes
Advice

The Switch menu opens a menu listing other Ulead 
programs for easy access. 

Click Menu commands on the left for help on other Album 
menus.

Window & Nested dialog boxes
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes
Advice

Window Menu dialog box
 Batch Manager

Nested dialog boxes
 Browse     PNG Save Options
 BMP Save Options     PSD Save Options
 EPS Save Options     RAS Save Options
 Font     Set Text/Bkg. Color
 GIF Save Options     TGA Save Options
 IFF Save Options     TIFF Save Options
 JPEG Save Options

Click Dialog boxes on the left for help on other Album 
dialog boxes.

 File Menu dialog boxes 
 View Menu dialog boxes
 Album Menu dialog boxes
 Thumbnail Menu dialog boxes
 Source Menu dialog boxes
 Window Menu dialog box
 Nested dialog boxes



File Menu dialog boxes
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes
Advice

 New  Page Setup
 Open  Print
 Shelf  Select Source
 Acquire  Preferences/Album

Click Dialog boxes on the left for help on other Album 
dialog boxes.

View Menu dialog boxes
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes
Advice

 Scroll To
 Auto Scroll
 Scan Play
 Slide Show
 Mode/Layout
 Toolbars & Panels

Click Dialog boxes on the left for help on other Album 
dialog boxes.

Album Menu dialog boxes
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes 
Advice

 Check  Backup 
 Move  Restore
 Copy  Sharing
 Rename  Properties

Click Dialog boxes on the left for help on other Album 
dialog boxes.

Thumbnail Menu dialog boxes
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes
Advice

 Insert
 Search
 Sort
 Import/From File
 Export 
 Relink

Click Dialog boxes on the left for help on other Album 
dialog boxes.

Source Menu dialog boxes
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus

 Print
 Move
 Copy 
 Rename
 Associate
 Create Folder



Dialog boxes
Advice

 Remove Folder

Click Dialog boxes on the left for help on other Album 
dialog boxes.

Advice
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes
Advice

Here are tips, techniques, and other tidbits to help you 
understand and use Album better.

    Why use a template?
    Why create an album from an already existing album?
    Why place albums on the shelf?
    Why choose Select Invert?
    Why resize thumbnails?
    Why refresh your album?
    Why select Write errors and journals to file?
    Why change thumbnails?

 File Menu
 Edit Menu
 View Menu
 Album Menu
 Thumbnail Menu
 Source Menu
 Window Menu
 Help Menu
 Switch Menu



 Standard toolbar
 Sort toolbar
 Search toolbar
 Tool panel
 Mark panel
 Status bar



Standard toolbar
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes

           Advice   

The Standard toolbar contains frequently needed 
commands and tools to make working with Album faster and
easier. Click above to find out more about each item.

Click Workspace on the left for help on other Album 
workspace items.

Sort toolbar
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes

           Advice   

The Sort toolbar contains frequently needed commands and
tools to make working with Album faster and easier. Click 
above to find out more about each item.

Click Workspace on the left for help on other Album 
workspace items.

Search toolbar
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes

           Advice   

The Search toolbar contains frequently needed commands 
and tools to make working with Album faster and easier. 
Click above to find out more about each item.

Click Workspace on the left for help on other Album 
workspace items.

Tool panel
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes

           Advice   



The Tool panel provides a link between the files you are 
organizing and your most frequently used applications. Click
on the Tool panel on the left for more information.

Click Workspace on the left for help on other Album 
workspace items.

Mark panel
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes

           Advice   

The Mark panel allows you to mark thumbnails to easily 
identify your files within an album. Click on the Mark panel 
above for more information.

Click Workspace on the left for help on other Album 
workspace items.

Status bar
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes

           Advice   

The Status bar contains commands to quickly change the 
current album's appearance on the screen and provides 
useful information about the currently selected album. 
Information varies depending on where the pointer rests. 
Click above to find out more about each item.

Note: Double-clicking anywhere on the Status bar opens the
Preferences: Album dialog box for configuring Album. Right 
clicking displays the Toolbars & Panels dialog box.

Click Workspace on the left for help on other Album 
workspace items.

Reading this Help
Welcome
What is Album?
Reading this Help

This help contains several aids to make navigating through 
topics easier.

    Jumps to the shown topic.

    Pops up extra information to enhance understanding.

    Jumps to a topic describing the listed nested dialog box.

    Pops up tips or advice to help you work more efficiently.



    Returns you to the top of a page after scrolling in a main 
window.

    Jumps down in the same topic to related information.

What is Album?
Welcome
What is Album?
Reading this Help

Album is a program that enables you to organize your files 
visually using thumbnails to represent the contents of a file. 
After creating thumbnails, you can append additional 
information placed in fields for a more detailed description of
the file. You can then search and sort on these fields to help 
you locate thumbnails.



New dialog box
Allows you to create a new album.

Album template Lists existing album templates.
Title Enter a name for the new album.
Album description Displays the selected template's purpose.
Total fields Displays how many fields exist in the selected template.
Fields list Displays the fields of the selected template.
Customize Click to view, modify, or define the characteristics of the selected template.



New dialog box
    General
    Fields 
    Advanced

Determines the name, location, and size characteristics for a new album.
Title Enter a name for the new album.
Create album file in folder Initially displays the current folder. Enter the desired folder or click Browse.
Browse Click to search for other folders.
Thumbnails attributes list Enter the size, compression, and color for the thumbnails in the new album. 
Description Displays the selected project's purpose. Enter new information, add new fields, or use the 

default.
Same As Click to select which album to use as the template basis and select the attributes to apply to the 

new album.



New dialog box
    General
    Fields
    Advanced 

Assigns fields to the thumbnails in an album.
Field name Enter the field name to add or modify.
Field type Select the data type for each field name. Add, modify, or delete from the user-defined list. 
Add Click to add a new field name to the current Fields list.
Change Click to change the selected field's field type.
Remove Click to remove the selected field from the fields list.
Total fields Displays the total number of fields in the album.
Fields list Displays the field names and their corresponding field types.
Same As Click to select which album to use as the template basis and select the attributes to apply to the 

new album.



New dialog box
    General 
    Fields 
    Advanced

Allows you to monitor the file activities in a folder.
Folder Enter a folder for Album to monitor for any changes.
Browse Click to search for other folders.
File types Enter the file extension ("*.ext") or select from the file formats drop-down list, the file type(s) to 

monitor contained in the folder. (You can select several file formats.)
File formats list Select the file format to monitor.
Enable folder monitoring Check to monitor the defined folder.
Password Set a password for access security. (Passwords can be up to 22 characters.)
Verify Enter the password again to make sure you typed it correctly.



Edit List/Keyword dialog box
Allows you to add, change, or remove items in the items list.

Total items Displays the total number of items defined in the List/Keyword field types.
New item Enter the new item to add to the current list.
Items list Displays the items defined in the selected field type. Click on an item to change or remove it.
Add Click to add the new item to the items list.
Change Click to change the selected item in the list with the newly defined item.
Remove Click to delete the selected item from the items list.
Remove all Click to delete all the items from the items list.
Load Click to load previously saved items from other files.
Save Click to save the current items list for future use.



Same As dialog box
Allows you to apply an existing album's attributes to the new album.

Source album Lists all opened albums in the workspace. Select the album to use as the template basis for 
the new album.

Apply attributes Select the source album's attributes to apply to the new album.



Open dialog box
Allows you to find and open existing albums. You can only open two albums at a time in the workspace.

Look in Locate the folder containing the album to open.
Click to view the contents of the next higher folder in your system.
Click to create a new folder
Lists only the filenames.
Lists filenames with details and statistics.
Folder list Lists all the folders in the current drive.
File name Enter the filename to open.
Files of type Select the file format to display.
Open as read only Check box to prevent any unwanted editing on the album.
Information Displays the version of the selected album, the number of thumbnails, thumbnail attributes and 

other file statistics.
Browse Click to search for other files or folders.
Properties Click to display more detailed information about the selected album.



Album Properties dialog box
Displays information about the selected album.

General Displays the album title, no. of records contained, password option, folder monitoring, file format 
version, description, and the associated mark file (pathway).

Fields Displays the names, types, and total no. of fields defined in the selected album.
File Displays the thumbnail size, compression, and color reduction. Also displayed are the filename, creation

date, save date, file size, and accessibility.



Shelf dialog box
Select an album to move back and forth between the workspace and the shelf.

Albums in workspace Displays the titles of the albums opened in the workspace. Select the album to move
onto the shelf.

Albums on shelf Displays the titles of the albums stored on the shelf. Select the album to move into the 
workspace or delete from the shelf and hard disk. 

=>    Click    to move the selected album from the workspace onto the shelf.
<=    Click to move the selected album from the shelf    to the workspace.
Close Click to close the Shelf dialog box.
Properties Click to display information about the selected album.
Delete Click to remove the selected album from the shelf and hard disk.



Batch Manager dialog box
Allows you to apply the same command to multiple albums.

Operation Select the command to apply to your albums. 
Albums Select the albums to apply the selected command to. (Use the Shift key with the mouse to select a 

range of albums or the Ctrl key with the mouse to select individual ones.)
Select All Click to perform the selected operation on all albums open in the workspace.
Deselect Click to deselect any selected albums.



Page Setup dialog box
Determines the settings to use for printing albums.

 Margins Define the left, right, top, and bottom margins for the page.
 Header/footer Enter the text to appear on the output pages, if any.
 Append Click to include page numbers, print date, or other information as headers or footers.
 Printer Click to change the printer settings.



Print dialog box
Allows you to define or modify print settings.

Printer Displays printer information. Click Properties to change the print settings.
Thumbnail range Specify the thumbnails to print.    Select All to print all the thumbnails in the album. Check 

Selection to print only the selected thumbnails in the album. Check Range to print a specified range.
Copies Specify the number of copies to print. You may choose to collate your printout by checking the 

Collate option.
Options Check to print thumbnails generated from their original files.
Page Setup Click to change page settings.



Send Mail dialog box
Allows you to send a message along with an album via e-Mail.

Send Files Define the files to send. Check the options on what files to send and how to handle them.
Message Text Enter a subject and message to send with the files in the boxes provided and click OK. The 

Choose Profile dialog box appears for defining more information.



Album Preferences dialog box
    General
    Font 
    OLE Representation

Determines how the Album program behaves in the workspace.
Check links to source files Check to automatically update files which have been modified. (Checking this 

option slows down processing time as you wait for Album to finish checking. Clear until automatic updating is 
necessary.)

Minimize on use Check to minimize the Album program everytime another application is opened from the 
Tool panel or Switch menu. Clear to keep album displayed in the background when you switch to another application. 

Free up memory when minimized Check to release any system memory used by an album by swapping it 
out to disk whenever it is minimized.

Confirm on thumbnail deletion Check to prompt for a confirmation message to appear whenever you 
delete thumbnails from an album.

Create best quality thumbnail images Check to generate thumbnails with a high degree of clarity and 
quality. Clear to speed up thumbnail insertion.

Display fixed-length tabs Check to display all the tabs at a fixed size. Clear to display tabs with lengths 
depending on the characters each tab title contains. (Control the number of characters with the Maximum tab width 
option.)

Print field data with source files Check to include all the thumbnail's data when printing the source file 
from Album.

Play annotation file after viewing thumbnails Check to automatically play the annotation file of a 
thumbnail right after opening the source file.

Maximum tab width (in characters) Specify the maximum number of characters for the names that appear
in tabs. (A low number offers more space to show more tabs on the screen.)

Number of recently removed files Set the number of recently removed files to display at the bottom of the 
File menu.

Delimiter used in Search toolbar Select the delimiter to use when performing a search using the Search 
toolbar.



 When you swap out to disk, the memory contents of the album are saved to a file in your TEMP folder. Restoring the 
album reads that file back into memory. This may slow down processing depending on the size of this file and the 
current state of your system's resources.



Album Preferences dialog box
    General
    Font
    OLE Representation 

Allows you to set the typeface to use in the album.
Font Select the desired typeface from the list to use in the album.
Font style Select the style for the selected font.
Size Set the size for the selected font.
Sample display Provides a preview for the typeface of the selected font style and size.



If you are in high resolution display mode, such as 1024x768, increase your font size to better see the names of the 
thumbnails. Likewise, in 640x480 resolution, reduce the font size.



Album Preferences dialog box
    General
    Font
    OLE Representation

Determines how Album objects are represented in the container (another application) document.
    Source object Select when contents and dimensions of the object are essential. 

Thumbnail only Select to place a thumbnail with the current display information set.
 Low resolution place holder Select to place a low resolution version of the object file in the container 

document to speed up proofing. To print the original file, update the thumbnail in the container document with Source 
object selected.

Album’s program icon Select to use the Album's program icon to represent the object file and minimize the
container's file size increase. (This does not provide a visual clue as to the contents of the file.)

Convert images as display mode Select to convert the image's data type to the current display mode 
when placed onto the clipboard. This saves system resources if you are using a low resolution display. (This is only 
enabled when running in a 256-color display mode.)



Displays the entire file in the container application. This allows you to clearly see the contents and dimensions of the 
object file without increasing the container's file size and slowing down its operation. But, if the source file is missing 
or is not an image/graphics file, it displays the thumbnail object.



Selecting this produces a grainy effect on the thumbnail's file when placed in the container application.



Preferences dialog box
    Memory
    Display
    Photo CD

Optimizes how Windows manages system memory while running Ulead programs.
Define additional folders for virtual memory Select the folders for storing temporary files while running 

Ulead programs. (Windows automatically determines the first folder.)
Hard disk Displays the available hard disk memory space.
Limit hard disk usage to Check and specify a value for the maximum disk space to have Ulead programs 

manage disk usage while running. This is useful for preserving disk space for saving other files.
Limit RAM usage to Check and specify a value for maximum RAM usage to have Ulead programs manage 

the system memory while running. This is useful if you run several different programs at once.



Make sure each of your temporary folders are on different drives or partitions to avoid temporary folders file conflicts.



Preferences dialog box
    Memory
    Display
    Photo CD 

Controls how the Ulead programs display graphics.
Hi-color dithering Check this if your display mode is HiColor and you want the True Color images to look 

their best on screen.
View images with a common palette Check this if you are working in a 256-color mode and want to open 

grayscale and color images at the same time or when comparing 256-color images with each other.
Ignore background quality Check to devote most system resources to viewing the active image. When 

selected, inactive images may appear discolored.
Monitor gamma Check to correct your display for manufacturers’ differences and the environment. When 

checked, set the gamma value so that the calibration square appears to be a single color.



This does not affect the actual data, it only affects the appearance when not active.



Preferences dialog box
    Memory
    Display
    Photo CD

Choose the data type and resolution for viewing PCD images.
Resolution Select the image resolution for opening PCD files.
Data type Select the data type for opening or viewing PCD files.



Photo CD images can be displayed at the following resolution(pixels):
64 x 96 (Base/64)
128 x 192 (Base/16)
256 x 384 (Base/4)
512 x 768 (Base)
1024 x 1536 (Base x 4)
2048 x 3072 (Base x 16)
4096 x 6144 (Base x 64)



Photo CD images can be displayed using the following data types:
RGB True-Color (24-bit)
Indexed 256-Color (8-bit)
Grayscale (8-bit)



Scan Play dialog box
Allows you to quickly browse through a large number of multimedia files.

Play all Select to play the entire clip of all the selected thumbnails.
Play only first __ seconds Select to scan play only a portion of each selected thumbnails' clip. Define the 

scan/play period (in seconds) for each clip.



Slide Show dialog box
    General
    Text & Color
    Music 

Allows you to control the time for each slide, define how the slide show plays a presentation, and add a sound track. 
You can also choose to control the slide shows manually.

Effect Select the transition effect that controls how one slide is replaced by the next. 
Speed Set the speed for the transition from one ‘slide’ to the next. 
Delay (in seconds) Set how much time elapses before the next slide starts to display. (If Synchronize with 

audio files option is selected, the time specified in the Delay option is used as a pause between each audio file.)
Synchronize with audio files Check to play selected sound files with image and graphic files.
Control manually with keyboard or mouse Check to control the transition yourself by using the mouse or 

the keyboard.
Repeat continuously Check to display the slide show in a continuous loop. (Select this option to use the 

slide show as a screen saver or run it continuously in the background.)
Resize large images to fit screen size Check to resize large images and graphics accordingly and display 

their entirety. (Images and graphics which are smaller than the screen size will not be resized.)
Use a common palette to show images Check to use the system palette to show images and protect them

from being distorted. (Only enabled in 256-Color display mode.)
Display true color images at best quality Check to ensure the best possible display of True Color images 

(Only enabled in 256-Color display mode.)
Hide pointer Check to prevent    the pointer from appearing during the slide show. Clear for the pointer to be

visible during the presentation. (When the pointer is hidden, press the Esc key to stop the slide show.)
Play audio annotation Check to play sound or MIDI files annotated to a thumbnail.
Play Click when ready to start the slide show.
Load Click to use a previously saved slide show.
Save Click to save the current slide show for future use.



The transition effect controls the way the slides are replaced. You can choose from the 18 types: Blind (Horizontal), 
Blind (Vertical), Chess(Large), Chess (Small), Dissolve, Interlace, Louver, Random, Spiral (Inwards), Spiral 
(Outwards), Strip (Left-Downwards), Strip (Left-Upwards), Strip (Right-Downwards), Wipe (Downwards), Wipe (to the 
Left), Wipe (to the Right), Wipe (Upwards).



Time specified does not include the time it takes to read or display images. This means that for large images, the time
between slides may considerably be longer than the specified amount.



Slide Show dialog box
    General 
    Text & Color
    Music 

Select the background color, text color, and the typeface for the text information displayed in the presentation.
Location Select where to display the text in the slide show.
Alignment Select where to align the text, to the left, right, or center.
Attributes to show Check the boxes for text information to display in the slide show.
Lines Specify how many lines to use for the text information.
Text color Click to choose a color for the text.
Background color Click to choose the background color for the slide show.
Font Click to display the different available fonts.
Play Click when ready to start the slide show.
Load Click to use a previously saved slide show.
Save Click to save the current slide show for future use.



Slide Show dialog box
    General
    Text & Color
    Music

Allows you to select the audio files to play during the slide show.
List files (to be played) Displays the audio files to play during the slide show.
Remove Click to delete the selected audio file from the list.
Remove All Click to delete all audio files from the list.
Add Click to search for other audio files and add them to the current list.
Info Click to display more a detailed information about the selected audio file.
Play Click when ready to start the slide show.
Load Click to use a previously saved slide show.
Save Click to save the current slide show for future use.
Repeat continuously Check to play the selected background music continuously. (If you are playing only 

one MIDI or sound (WAV) file, select this option so that the sound doesn't stop during the whole presentation.)



Toolbars & Panels dialog box
Allows you to show or hide the toolbars, Tool panel, status bar, or Mark panel in the workspace. It offers the options 
for color and large buttons. 

Standard toolbar Check to display the standard toolbar. Clear to hide it.
Sort toolbar Check to display the sort toolbar. Clear to hide it.
Search toolbar Check to display the search toolbar. Clear to hide it.
Tool panel Check to display the Tool panel. Clear to hide it.
Mark panel Check to display the Mark panel. Clear to hide it.
Status bar Check to display the status bar. Clear to hide it.
Color buttons Check to display the toolbars, Tool panel, Mark panel, and status bar icons in color. Clear to 

show grayscale icons.
Large buttons Check to display the toolbars, Tool panel, Mark panel, and status bar in large icons. Clear to 

show small icons.
Show ToolTips Check to display hint messages whenever you rest your mouse over a screen element.



Check dialog box
    Missing Files
    Modified Files 

Checks thumbnails whose links are no longer intact for further action.
Files Lists all the missing source files that were linked to the album.
Relink Click to locate and reestablish the link between the thumbnails and their source files. 
Delete Click to delete the selected filename(s) from the list of missing files and also the corresponding 

thumbnail(s) from the album.
Update Only available in the Modified files section. 
Properties Only available in the Modified files section. 



Check dialog box
    Missing Files 
    Modified Files

Allows you to check the thumbnails whose source files have changed for further action.
Files List all the modified files that are linked to the album.
Relink Click to locate and re-establish the link between thumbnails and their source files. Specify the 

location of the source files.
Delete Click to delete the selected filename(s) from the list of modified files and also the corresponding 

thumbnail(s) from the album.
Update Click to update the thumbnails with the latest version of their source files.
Properties Click to display more information about the selected source file. 



Relink dialog box
Allows you to define the location for relinking selected thumbnails to their source files.

Drive Select to relink the thumbnail to the specified drive where the source file is located. 
Folder Select to relink the thumbnail to the folder where the source file is located.
Album drive Select to relink the thumbnail to the current album's drive where the source file is located. (To 

make sure that the Album program searches in the right drive when source files are moved to a different drive, select 
this option.)

Apply to all thumbnails in album Check to relink all the thumbnails in the album and their source file in the
specified source file location.



When selected and initialized, any files that are not currently on the same drive as the album file prompts an error 
message. Click YES to if you still want to relink the file or NO if not.



Move/Copy dialog box
Allows you to move or copy an album to another folder.

Move/Copy album file to folder Enter the drive and folder to move or copy the album to.
Folders list Displays the list of existing folders. Select the folder for the album.
Drives Lists all the available drives. Select the drive for the album.
Information Displays information on the number of selected thumbnails, required disk space, and the 

available disk space on the selected drive.
Browse Click to search for other files or folders.
Network Click to connect to a network.



Map Network Drive dialog box
Allows you to connect to a network by specifying the following information.

Drive Specify the network drive.
Reconnect at logon Check to automatically connect to a network everytime you logon.



Templates are predefined examples of what you can use an album for and each one has a list of fields associated 
with it. These are provided to help you get started right away in creating an album. To save time required in setting up
an entire album by yourself, choose the appropriate template to base your new album on and later modify it. (If you 
only want to create a multipurpose album, choose the default General Project.)



Certain field types can be modified (provided that the field name is a user-defined field) by clicking on the Edit button.



When the criteria defined in a search consists of more than one word, you must encase it with a delimiter.



Send dialog box
Allows you to send a message along with an album.

Send Files Define files to send. Check the options on what files to send and how to handle them.
Message Text Enter a subject and message in the boxes to send with the files and click OK. A dialog box 

appears for defining e-mail information.
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Images, when mentioned in the context of computer 
graphics, are usually considered to be bitmaps. They are 
composed up of many dots (called "pixels") arranged on a 
grid. If the pixels are small and close enough, you will not be
able to see them as individual dots. Rather, they will form 
patterns of colors and shapes. It is this arrangement that 
forms recognizable pictures for us to see.

The simplest images only contain black or white pixels. 
Shades and "grays" are formed by combining them in 
patterns that the human eye has trouble noticing. For 
example, the gray rectangle below is actually a pattern of 
black and white pixels. The inset shows the actual pattern 
used to create that shade.

More complex images can contain over 16 million different 
colors. However, these additional colors come at the cost of 
increased file size.

When thinking about computer images, there are three 
things to consider:

           Data type   — for dealing with color and shading.
File Format — to determine how the computer 

stores and reproduces information.
Resolution — to determine the size.

While the number of colors a computer can display may be tremendous, that does not mean you can tell them all 
apart. It is commonly accepted that the human eye can only distinguish between 10,000 or fewer colors at any given 
time. For further details, read About     Color  
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The data type determines how many colors an image can 
contain and how they are determined. Although most 
computers can display almost any data type, how it appears 
may vary. For example, a black and white monitor can 
portray color images, but the colors appear in black, white, 
and shades of gray. Similarly, a true color image can be 
shown on a 16-color display, but many of the colors will be 
dithered, (patterns of other colors).

No discussion of data type is complete without mentioning 
the number of bits it is composed of. It is this number that 
determines how many colors can exist in a single file. By 
raising two to the power of bits you can find out the 
maximum number of colors possible. For example, a black 
and white image data type is a one-bit data type. Thus you 
can only have two colors: black or white. Alternatively, an 
eight-bit data type allows 2 to the 8 (256) different colors. 
The amount of memory needed is directly related to the 
number of bits, so an image with a 16-bit data type would be
four times larger than the same image with a four-bit data 
type.

Currently, there are six widely accepted data types used in 
PCs today. In order of the amount of memory required, 
(least to most), they are:

Black and White    (1-bit)
Indexed 16-color    (4-bit)
Grayscale    (8-bit)
Indexed 256- color    (8-bit)
RGB HiColor    (15- or 16-bit)
RGB True Color    (24-bit)

Black and White
Black and White is a one-bit data type. That does not mean
that shades of gray are impossible though. By combining 
black and white pixels in special patterns, an illusion of 
lighter or darker shades can be created. For example, the 
gray square below is actually a pattern of black and white. 
The inset shows the actual pattern:

Grayscale
Grayscale images are eight-bit data type images. They 
contain black, white, and 254 different shades of gray. If you 
are working on images for black and white printing, this is a 
good format to work with. You can easily draw and modify 
images to create the shading and accents you want. When it
is time to print out, you will have a very good idea about the 
appearance of the actual printout. 

Indexed Color

Indexed Color images have color tables to define which 
colors can be used. The Indexed 16-color data type is a 4-
bit data type while the 256-color data type is an 8-bit data 
type. Just like black and white images, additional colors can 



be simulated by combining existing colors in a pattern. For 
example, the 16-color image below creates purple by using 
a pattern of red and blue pixels:

Since each image can have its own unique table, the 
choices of available colors for two different images may be 
completely different. 

RGB
RGB stands for Red, Green, and Blue, the three colors your 
monitor uses to create all its colors. There are currently two 
popular RGB data types; HiColor and True Color. HiColor is 
a 15- or 16-bit data type and can produce 32,268 or 65,536 
different colors respectively. RGB True Color is a 24-bit data 
type and can produce over 16.7 million colors. Both of these
data types are particularly useful if you are working with 
photographic quality images on your computer.

To understand how the RGB data types work, lets look at 
the True Color version. RGB True color divides its 24 bits 
between Red, Green, and Blue so that each color has eight 
bits. Thus, there can be 256 shades of each color ranging 
from 0, (none), to 255, (intense). By combining shades of 
each color together, other colors in the visible spectrum can 
be created.

 The problem with RGB True Color is that it demands huge 
amounts of memory. To limit this problem, RGB HiColor was 
developed. There are two forms of RGB HiColor and they 
each work a little differently: 15-bit RGB HiColor, rather than 
devoting eight bits to each color, only assigns five. Thus 
Red, Green, and Blue each have only 32 shades. 16-Bit 
RGB usually devotes an extra bit to one of the primary 
colors.

A color table is a list of the allowable colors for a given image. By defining the Red, Green, and Blue values for each 
space in the table you can determine which colors that image can contain. For more detailed information, read About
Colors



As a rule, green is usually allocated the extra bit because the human eye is more sensitive to it.
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Almost every computer program has its own unique way to 
store information for later retrieval. The way programs 
organize this information is what makes up the file format. 
There are probably over 100 different file formats for 
graphics files alone. Some of these files are unique to 
specific programs while others are general formats that 
extend over several platforms. The two things to consider 
when discussing file formats are

Representation Scheme – how the computer 
interprets data to reproduce it.

Compression Scheme – how the computer 
utilizes memory to store the image.

Representation Scheme
Bitmap files may be broken down into two or more sections. 
Each section has a unique function to tell the computer how 
to reproduce the file. The simplest bitmap image files will 
have two or three parts: the header, bitmap data, and 
optionally, the footer.

The header contains important information to prepare the 
computer for the data that follows. It may include some or all
of the following items:

Bitmap data makes up the bulk of the file. It contains the 
“meat” of the information. It consists of values for each pixel 
in the image. The computer reads these values, and using 
the information from the header reproduces them in the 
proper place in the image.

The footer is an optional addition to the format. In many 
cases, information in the footer consists of data that was 
omitted from the header because of version changes.
 

Compression
There is an unwritten law that states, "No matter how big 
your hard disk is, you always need 10 MB more." Depending
on the size and data type, images can be major contributors 
to this problem. For example an uncompressed, low-
resolution, (100 dpi), one-page, black and white fax would 
occupy about 935 KB. Imagine how much more space 
would be required for full color images! That is where 
compression comes in, it manages the image data so that 
less space is required to store the image.

Most compression schemes fall into one of two categories: 
lossless and lossy. Lossless compression means that no 
data is irreparably altered in the process of "shrinking" and 
"expanding" a file. Lossy compression, however, does 
change the original data. In most cases, the changes are 
insignificant, and rarely can the naked eye make them out 
even when magnified to sixteen times normal size. The 
advantage of lossy over lossless is that lossy schemes 
usually offer much better compression ratios. Thus, files are 
smaller.

Think about the compression method when saving images. 
If you have a True Color or other high quality image where 
there are few similarities from pixel to pixel, using lossless 
compression can actually result in a larger file! On the other 
hand, if you work on an image with a large solid background



or one-color regions, you can save valuable disk space. 
Similarly, don't be put off by lossy compression schemes. 
Usually, the depreciation of the data is too small for most to 
see. Click below to see if you can tell the difference between
compression methods:

Can you tell the difference between compression methods? 

The most common compression methods are:
Pixel Packing — More a memory management 

scheme than compression method, it shifts data to fill every 
available memory register instead of isolating each piece of 
date in its own byte register. Using pixel packing often slows
down performance when opening and closing files.

Run Length Encoding (RLE) — A compression 
method that looks for continuous occurrences of the same 
information. It then stores that occurrence in two bytes. The 
first byte defines the number of repetitions; the second what 
is to be repeated. For example, the string "AAAAAAAAA" 
would    become "9A" (9 bytes becomes 2 bytes) This type of
compression is good for simple images with large 
continuous color areas. But if a file has few or very small 
continuous region, it could cause the file to grow in size 
instead of shrink. The best way to demonstrate this is to use
a simple sentence: "Reading books is good." This sentence 
is 21 bytes long, (including spaces and the period). Using 
RLE compression, it would be 38 bytes long, almost double 
the size! 

CCITT — A .compression method that uses a pre-
defined look-up table to identify and replace expected 
patterns in the actual data. Think of this as shorthand for 
computers.

 LZW — A proprietary compression method that 
uses a look-up table called a dictionary. The difference is 
that it creates its own dictionary from the original data. So 
the dictionaries in LZW files tend to be smaller and more 
well suited to the specific data they represent. Similar to 
RLE compression, images with few regular patterns would 
likely grow instead of shrink using this compression.

JPEG    A was developed to create a standard for 
sending images over digital communication lines. Although it
is a lossy compression method, most high and true color 
images compressed with it show little or no degradation, 
thus it is becoming one of the most popular ones in use 
today. The methods used to achieve JPEG compression 
vary and are and difficult to explain.

Here are two eight gallon barrels. The first one is half full of red sand; the second of green. To save barrels, we are 
going to put the green sand on top of the red sand, making sure neither color mixes.



This image contains 121 red, green, blue, brown, or white pixels. The picture below shows a possible way of coding 
the bitmap where R means Red, G means Green, B means Blue, N means Brown, and W means White. When we 
store this image without compression, it might look like: BBBBBBBBBBBBBGGBBB.....BBBBBRRRRRBBB. The total 
amount of memory used would be 121 bytes. Using RLE compression, this might become 13B2G3B.....5B5R3B. The 
total memory used would be 82 bytes, a 25% reduction in size.



What kind of compression is being used?
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The resolution is the number of pixels in each inch of an 
image and is measured in ppi, (pixels per inch) or dpi, (dots 
per inch). At first, it can be a little confusing because it can 
have different significance depending on what you are 
doing. When scanning an image resolution affects its clarity;
higher resolution scans are more precise. Once an image is 
in the computer, it takes on a whole new meaning. Now it 
represents image size. If you change resolution, the number
of pixels remains the same, but their individual sizes and 
proximity to each other changes. So, If you scan an image 
at one resolution, and then increase the scanned image's 
resolution to a higher one, the resulting image, when 
printed, will be smaller. However, if you look at it on your 
monitor, you will see no changes in the size because your 
monitor's resolution and the total number of pixels did not 
change.

About computer graphics
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There are three general formatting methods for representing
graphics on a computer:

Bitmap – Images are defined as a series of dots, 
each having its own assignment in a grid.

Vector – Drawings are composed of shapes 
defined by starting and ending points for lines to make each 
shape.

Metafile – Pictures combine both bitmap and 
vector characteristics, using the vector format to define 
shapes, outlines, and fills but the bitmap format to do 
complex shading and coloring.

Bitmap graphics
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Files that use a bitmap format are often referred to as 
images. They define the picture with an assignment for each
pixel in the picture. Most images produced by scanners, fax 
machines, and other optical input devices produce bitmap 
images. An other popular use for bitmap files is photographs
and other images requiring a wide array of colors or filled 
regions. 
Bitmap Plusses and Minuses
The advantages of bitmaps are:

They are easy to create and store
They are easy to reproduce on several different 

types of output devices
Bitmaps offer tremendous flexibility in displaying a 

range of colors
It is easier to create solid colors with bitmaps

The disadvantages to bitmaps are:
Files tend to be very large when compared with 

other formats
Editing shapes can be very difficult, especially if an 

image is composed of many similar colors.



Resizing bitmap images often results in noticeable 
distortion to the original data.

Vector graphics
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Computer graphics began with the vector format. This is 
because most of the devices used to display and print were 
not pixel based, but line based. The displays were modeled 
after the oscilloscope, and drawings were printed on devices
called plotters.

Vector graphics do not concern themselves with each pixel 
in the drawing. They are shape-based formats composed of 
one or more objects. Each object is defined by two (or more)
points that define its shape. For example, a straight line 
would have two points marking the start and end. A square 
might consist of two or four points to mark the line segments
or shape. 

The vector format is most useful for drawings where high 
levels of accuracy and smooth, well defined lines are most 
important. Some examples include blueprints, exploded 
view drawings, and poster art.
Vector Plusses and Minuses
The main advantages of vector formats are:

They can easily be scaled up or down with 
marginal loss in accuracy.

They are well suited for creating three dimensional 
drawings.

Vector file sizes are usually much smaller than 
similar looking bitmaps.

The disadvantages to vector formats are
They can be highly dependent on the device that 

displays or prints them. 
The detailed attention to shading and color 

required for photographic quality is practically impossible.
Detailed vector files may take longer to draw on 

screen or print out since each object is independent of 
others in the file.

Metafile graphics
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At first glance, metafiles would seem to be the ideal file 
format because they combine both vector and bitmap 
characteristics. While the format may be nice in its final 
form, there are many complications associated with 
designing software that can create and work on metafiles 
effectively. For this reason, many programmers avoid using 
this format. The primary use for metafiles is for transferring 
files over different hardware platforms.
Metafile Plusses and Minuses
The advantages to metafiles are:

They are usually extremely portable.
Uncompressed, they tend to be smaller than a 

similar bitmap.
They compress well.



The primary disadvantage to metafiles is
They are very complex and difficult to edit.

For a more complete explanation of the issues involving images and computers, see Images.
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 Colors are formed by light reflected off a surface. Although 
there are an infinite number of colors in the world, there is a 
limit to how many we can see. Without considering a 
person's age or health, the first limitation comes from the 
visible spectrum. Only light between 380 (red) to 770 
(purple) nanometers in wavelength is visable by the human 
eye. We can see any color in this range, but it is generally 
believed that people can only distinguish between 10 to 16-
million different colors. Further, even under the best lighting 
conditions, in any single moment, the range is limited to 
somewhere around 10,000. And under poor or colored 
lighting, this number is further reduced.    

It is important to remember this when working with digital 
color because there is a very real limit on the number of 
colors you can display or produce depending on the format, 
available memory, and your equipment. On the PC platform,
the fewest is two, Black and White, while the most 
sophisticated color formats may allow over 68 billion colors 
at one time!

Depending on your needs, there are several different ways 
for generating colors. Each has its own strengths and 
weaknesses. The most common models are:

RGB Cube — Generally used with light emitting 
devices like TV's and monitors

CMYK Color Model — Usually used for printed 
media like books

HSB Cone — A popular format for photographers 
and painters

YUV / YIQ Color Model — A variation of the RGB 
Cube used for sending images over digital networks.

RGB color model
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The RGB model is an additive color model. By that we mean
color is added to black to create the new ones. The more 
color you add, the closer to white you can get. This color 
model is built around the three primary colors of Red, 
Green, and Blue.

This picture of an RGB cube illustrates how the system 



works. The color red starts from nothing and gradually 
increases along one horizontal (x) axis. Along a second 
horizontal (y) axis the same thing is done for green. The 
vertical (z) axis uses blue. At the point where all three axes 
meet, there is no color, hence black. Diagonally through the 
cube, across from this point, Red, Green, and Blue are fully 
represented, creating white. If you could see the line 
connecting these two points, you would see shades of gray. 
As you move away from the origin along each axis, the 
value for that color increases. New colors result from 
combining the primary colors in proportion to the distance 
from the origin.

This color model is most popular in luminous media such as 
computer monitors and televisions. The reason is that when 
these devices are off, the display goes dark (black). So, 
adding colors to the existing black is easiest.

CMYK color model
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The CMYK color model is a subtractive color model. By that 
we mean that new colors come from the removal of color 
from white.

Like the RGB cube, the CMYK model is based on three 
primary colors — Cyan, Magenta, and Yellow. If you look for 
these colors on the RGB cube, you will see they are 
complements (opposites) of the RGB colors. (Cyan is 
complement of Red, Magenta of Green, and Yellow of Blue.)
These colors differ from the RGB primary colors in that they 
absorb instead of reflect light.

At the origin, (0,0,0), no color would be removed and white 
would result. Similarly, if sufficient amounts of all three 
colors were blended, all red, blue, and green would be 
absorbed, hence black.

So we see what C, M, and Y mean in CMYK, what about K? 
K represents a fourth channel added to the model for Black 
and Grays. In an ideal environment, this channel should not 
be necessary, but in the real world, blending cyan, magenta,
and yellow rarely produces a rich, dark black; it usually 
creates a dark muddy brown. This is due to subtle impurities
in the colors when they are blended. To overcome this 
problem, a pure black (and gray) channel is added for when 
those colors are needed.

The CMYK color model is used primarily in the printed 
media. This is because printed surfaces are reflective, (that 
is they allow us to see colors not absorbed by the surface). 
By using colors from the CMYK model, we can influence 
which colors are absorbed and which are reflected.

HSB color model
Overview
Computer graphics
Images
Color

The HSB cone is a completely different concept from the 
RGB and CMYK models. Rather than using three primary 
colors to create new ones, it treats every color of the 
spectrum as its own unique entity (Hue). Then black is used 
to control the brightness and white the purity (Saturation).



The colors of the spectrum are arranged in a circle around 
the top of the cone and identified according to their position 
relative to red. The three primary colors are arranged 120° 
apart with their complements directly opposite. Pure white is
at the top center of the cone and black at the apex. If you 
follow a line from the outer edge to the center, you will see 
color getting brighter until the bright white is achieved. 
Similarly, if you follow a line from the outer edge to the apex,
color darkens until only black is visible.

The best example of how the HSB model works is shown in 
painting. Generally speaking, artists will pick pure colors to 
work with. Then to tint the color, they add white. To shade, 
they add black. Finally, to create a tone, they will combine 
black and white with the pure color.

YUV / YIQ color model
Overview
Computer graphics
Images
Color

These models are variations of the RGB model. Their 
primary uses are for sending television signals, (YUV for 
PAL and YIQ for NTSC), but is also of interest because of its
application in JPEG compression. This model interprets 
colors in terms of the luminance (Y), and two degrees of 
chrominance or color (U,V). The biggest downside to this 
model is that it actually changes some data during the 
conversion.

Try looking at a picture of the bright blue sky under a fluorescent white light and then under a yellow light. In the 
second case, the sky will take on a green tint. Under these conditions, some colors you might otherwise easily 
distinguish may be masked by the environment.



Don't be too discouraged by the implied limitations of Black and White. By combining these two colors smartly, 
several other shades can be simulated in many types of images. For more about how to create more colors from a 
small palette, see Images - Data Type.



At first, you might think slides and film would use the RGB color model. Actually, CMYK is more popular. This is 
because the media upon which we are viewing is not the light that projects the images; it is the wall or film where it is 
projected.



This is an uncompressed image. It is about 65 KB.



This image was saved using JPEG compression. This lossy compression scheme reduced the total file size from 65 
KB to a little more than 9 KB! 



This image is compressed with a lossless compression method. But when the file was saved the size increased from 
65 KB to 66 KB! The reason for this is that there are so many dissimilar colors and no easily recognizable patterns.



This picture illustrates three types of vector shapes. Using the upper left corner as the reference, image A shows the 
simplest vector shape, the line. Two points identify the ends and a straight line connects the points. In a file, this 
might look like "line,1,1,6,8" Image B is a square. One possible way to represent it could be "Square,11,2,17,8", 
which identifies the shape an two diagonal corners. Image C is a curved line. It might be represented as 
"Arc,3,15,8,12,13,18,16,18" The program would calculate the curvature for a line to connect those points in 
sequence. 



Ulead supported file formats
Overview
Computer 

graphics
Images
Color

There are over one hundred different graphics file formats 
currently in use on computers. It would be impossible to 
cover them all here. Click below for details about the formats
supported by Ulead programs:
BMP PCX PSD UFO
CUR PCD TGA
JPG PNG TIF

Key

Key

This is a key to the symbols appearing to the left of each 
format description.

Full Supported Ulead programs can open and save them.

Partial Support Ulead programs can open these files but 
can only save them as bitmaps.

Read Only Ulead programs can read these files, but cannot 
save to the same format.

Bitmap (BMP)

This is a widely recognized format made popular by 
Microsoft Windows and IBM OS/2. It supports several data 
types ranging from black and white all the way up to 24-bit 
True Color. It is good for images you want for your Windows 
wallpaper or to distribute to others who you know have 
Windows, but are not sure of what else. Although the BMP 
format supports RLE compression, most programs 
(including Ulead) do not take advantage of it.

Microsoft Windows Cursor (CUR)

You mouse pointer likely uses (or at one time used) 
the .CUR format. The features that set apart from most other
file formats are:
1. It can only be 32 x 32 pixels in size.
2. It is a 2-bit data type, using Black, white, transparent, and

inverse.

When Ulead programs open .CUR files, the transparent 
color appears as white and the inverse color as black.

JPEG File Interchange Format (JPG)

The JPEG format is best suited for digital photographs and 



other natural-looking images. It is not as good for precise 
artwork such as line-art. This is because some "averaging" 
takes place during compression, and edges may be blurred. 
In photographs, this is not so noticeable because such 
sharp edges are rare.

It uses a lossy compression method to achieve compression
ratios of up to 100 to 1. This is far better than 10 to 1 which 
may be the best most other compression methods might 
produce. This format supports grayscale and True Color 
data types; because it uses a lossy compression method, 
indexed and black and white data types do not reproduce 
well and are not supported. One interesting feature of this 
format is that you can vary the degree of compression. So 
you can decide what level of data retention vs. space 
savings is best for your needs.

Kodak Photo CD (PCD)

When the prospect of using computers to save images 
became a reality, Eastman Kodak developed this format to 
store photographs digitally. This proprietary format is used 
by images in Kodak CDs. To support multiple display modes,
each PCD file contains image data in 5 resolutions, and 
allows you to choose between viewing the image in True 
Color, indexed 256 color, or grayscale.

PC Paintbrush (PCX)

Originally developed by ZSoft Corporation for their PC 
Paintbrush program, this format gained early popularity. 
Shortly after its development, ZSoft entered into several 
OEM agreements with early fax board and scanner 
manufactures. As a result, this format has become an 
important standard on the PC and other desktop platforms. 
It supports all data types. 

Some PCX images do not include resolution information in 
their headers. If a Ulead program opens such an image, it 
will automatically match the image resolution with the 
current display resolution.

Adobe PhotoShop (PSD)

This format was created by Adobe Systems Inc. for use with 
their high-end image enhancement program. It supports all 
data types and is one the most popular formats for 
professional photographers who use desktop computers to 
touch up their work.

Targa (TGA)

This format, one of the principal true color image formats, 



can store image data with up to 32 bits per pixel. Compared 
to TIF and JPEG which are other options for true color 
images, TGA is relatively simple and therefore widely used 
in imaging programs. The only drawback to this format is 
that it lacks a good compression scheme.

Tagged Image File Format (TIF)

This is a standard file format for most imaging programs 
which supports all data types from monochrome up to 24-bit 
true color, as well as many color models and compression 
schemes. An even more powerful aspect of TIF is that its 
files can move easily between platforms, making it an ideal 
format for storing image data.

    About images 
    Data type 
      File format   
    Resolution 



    About computer graphics 
    Bitmap graphics 
    Vector graphics 
    Metafile graphics 
    Ulead supported file formats 



Ulead File for Objects (UFO)

This proprietary file format was designed by Ulead Systems 
for use in PhotoImpact. It is the only format supported by 
Ulead programs that allows objects that have not been 
merged to the base image to be retained. UFO files use 
RLE or no compression when saved.

Portable Network Graphics (PNG)

PNG, pronounced "Ping," was developed to replace the GIF 
format which is losing popularity due to proprietary 
concerns. It is designed primarily for sharing image data on 
line. Perhaps one of the most fascinating aspects of this 
format is how it opens images. Unlike most other file 
formats, this one is designed to show a representation of the
image as fast as possible. When opening a PNG image, it 
first appears out of focus and gradually becomes more clear.
In this way, you gain a better idea of the entire image faster, 
(and can cancel a download sooner if you see that you don't
want it). Another feature, especially designed for on-line 
concerns, is easy file checking for transmission accuracy 
and against file corruption.    PNG supports indexed 256 
color, true color, and grayscale data types.

    About color 
    RGB color model 
    CMYK color model 
    HSB color model 
    YUV / YIQ color model 



General
General
Working with 

thumbnails
Managing source 

files
Managing the active

album 
Viewing
Locating thumbnails
Customizing the 

Tool panel 
Dragging-and-
Dropping

    Managing the Album program
    Calibrating the display 
    Creating a new album
    Using the Album shelf
    Opening an album
    Using the Batch Manager
    Finding files on disk 
    Obtaining information
    Printing an album
    Closing an album
    Deleting an album
    Exiting Album

Working with thumbnails
General
Working with 

thumbnails
Managing source 

files
Managing the active

album 
Viewing
Locating thumbnails
Customizing the 

Tool panel 
Dragging-and-
Dropping

    Inserting thumbnails
    Selecting thumbnails
    Changing the order of thumbnails
    Copying a thumbnail to another album
    Checking links between thumbnails and source files
    Relinking thumbnails and source files
    Preparing CD-ROMs for distribution
    Working with field data
    Working with annotations 
    Changing a thumbnail
    Embedding or linking thumbnails from an album
    Moving thumbnails between tabs
    Resizing thumbnails

    Moving thumbnails from one album to another 
    Cutting thumbnails from an album 
    Deleting thumbnails from an album 
    Arranging the order of thumbnails



Managing source files
General
Working with 

thumbnails
Managing source 

files
Managing the active

album 
Viewing
Locating thumbnails
Customizing the 

Tool panel 
Dragging-and-
Dropping

    Opening source files
    Converting file formats and data types
    Moving source files
    Copying source files
    Deleting source files
    Renaming source files
    Changing file attributes
    Changing file association
    Checking links between thumbnails and source files
    Printing source files
    Creating a folder for the source files
    Removing a folder of source files

Viewing
General
Working with 

thumbnails
Managing source 

files
Managing the active

album 
Viewing
Locating thumbnails
Customizing the 

Tool panel 
Dragging-and-
Dropping

    Creating a slide show
    Scrolling an album
    Using Scan Play
    Viewing multimedia files
    Managing the Album program
    Displaying two panes in the workspace
    Using tabs
    Viewing albums in different modes
    Controlling the Album workspace
    Displaying another program with Album
    Using PhotoImpact Explorer to view files

Locating thumbnails
General
Working with 

thumbnails
Managing source 

files
Managing the active

album 
Viewing
Locating 

thumbnails
Customizing the 

Tool panel 
Dragging-and-
Dropping

    Defining album fields
    Using the Mark panel
    Performing a search
    Arranging the order of thumbnails

    Assigning marks
    Editing and defining marks
    Loading and saving marks



Customizing the Tool panel
General
Working with 

thumbnails
Managing source 

files
Managing the active

album 
Viewing
Locating thumbnails
Customizing the 

Tool panel
Dragging-and-
Dropping

    Adding programs
    Removing programs and program groups
    Displaying a program group
    Repositioning the Tool panel
    Changing properties of a program

Dragging-and-Dropping
General
Working with 

thumbnails
Managing source 

files
Managing the active

album 
Viewing
Locating thumbnails
Customizing the 

Tool panel 
Dragging-and-
Dropping

    Adding programs to the Tool panel
    Inserting thumbnails into an album
    Opening album files into the workspace
    Copying/Moving files between albums
    Embedding or linking files in other applications
    Moving thumbnails between tabs
    Opening source files from the Tool panel
    Storing objects from an application into an album

Managing the active album
General
Working with 

thumbnails
Managing source 

files
Managing the 

active album
Viewing
Locating thumbnails
Customizing the 

Tool panel 
Dragging-and-
Dropping

    Choosing helpful tools
    Moving an album to another location
    Copying an album
    Renaming an album
    Backing up an album
    Restoring an album
    Sharing an album
    Refreshing an album
    Sending an album
    Changing an album's properties
    Closing an album



Status bar and toolbars Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes 
Advice

This pop-up menu appears when you right click on the 
Status bar or any of the toolbars. It contains these 
commands. Click on the command you have a question 
about for more information.

    Standard 
    Sort
    Search 
    Tool panel
    Mark panel
    Status bar
    Toolbars & Panels 

Click Right click Pop-up Menus on the left for help on 
other pop-up menus.

Tool panel Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes 
Advice

This pop-up menu appears when you right click on the Tool 
panel. It contains these commands. Click on the command 
you have a question about for more information.

    Standard     Status bar
    Sort     Attach Left
    Search     Attach Right
    Tool panel     Floating
    Mark panel     Toolbars & Panels

Click Right click Pop-up Menus on the left for help on 
other pop-up menus.

    Tabs by Menu
    Compact Mode Menu
    Change layout Menu
    Mark panel Menu
    View Mark Menu



    Status bar and toolbars Menu 
    Tool panel Menu
    Album    Menu 
    Workspace Menu
    Thumbnail Menu
    Edit Pane Menu



Album Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes 
Advice

This pop-up menu appears when you right click anywhere 
on an opened album (except minimized) in the workspace. It
contains these commands. Click on the command you have 
a question about for more information.

    Slide Show     Delete
    Print     Rename
    Close     Check
    Put on Shelf     Mode
    Move     Properties
    Copy

Click Right click Pop-up Menus on the left for help on 
other pop-up menus.

Workspace Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes 
Advice

This pop-up menu appears when you right click on the 
workspace. It contains these commands. Click on the 
command you have a question about for more information.

    Windows opened files list 
    More
    Minimize All

Click Right click Pop-up Menus on the left for help on 
other pop-up menus.

Thumbnail Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes 
Advice

This pop-up menu appears when you right click on a 
thumbnail. It contains these commands. Click on the 
command you have a question about for more information.

    View     Source submenu
    Open     Move
    Copy     Copy
    Clear     Delete
    Properties     Rename

Click Right click Pop-up Menus on the left for help on 
other pop-up menus.

Edit Pane Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click Pop-

up Menus
Dialog boxes 
Advice

This pop-up menu appears when you right click on an area 
where you edit the album fields. It contains these 
commands. Click on the command you have a question 
about for more information.

    Undo
    Cut
    Copy
    Paste
    Clear 
    Apply to All
    Save



    Restore

Click Right click Pop-up Menus on the left for help on 
other pop-up menus.

Tabs by Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click 

Pop-up Menus
Dialog boxes 
Advice

This pop-up menu appears when you click , at the upper 
right corner of the currently displayed album. This icon is 
visible when tabs are on display. Click on the command you 
have a question about for more information.

    Tabs by Category
    Tabs by Media
    Move Thumbnail 
    Switch to 
    Hide Tabs

Click Standard click Pop-up Menus on the left for help on 
other pop-up menus.

Compact Mode Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click 

Pop-up Menus
Dialog boxes 
Advice

This pop-up menu appears when you click  while in 
compact mode display. It contains these commands. Click 
on the command you have a question about for more 
information.

    Compact mode menu bar commands
    Switch to Normal Mode
    Tile With
    Always on Top
    Horizontal Panel
    Vertical Panel

Click Standard click Pop-up Menus on the left for help on 
other pop-up menus.

Mark panel Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click 

Pop-up Menus
Dialog boxes 
Advice

This pop-up menu appears when you click  in the Mark 
panel or by double clicking on the Mark panel's title bar. It 
contains these commands. Click on the command you have 
a question about for more information.

    Move     Convert to Keywords
    Size     Clear All
    Close     Edit 
    Assign Selected     Load
    Clear Selected     Save

Click Standard click Pop-up Menus on the left for help on 
other pop-up menus.

View Mark Menu
Workspace This pop-up menu appears when you click  in the Mark 



Menu commands
Right click Pop-up 

Menus
 Standard click 

Pop-up Menus
Dialog boxes 
Advice

panel. It contains these commands. Click on the command 
you have a question about for more information.

    And
    Or
    View All

Click Standard click Pop-up Menus on the left for help on 
other pop-up menus.

Change layout Menu
Workspace
Menu commands
Right click Pop-up 

Menus
 Standard click 

Pop-up Menus
Dialog boxes 
Advice

This pop-up menu appears when you click  in the Status 
bar. It contains these commands. Click on the command you
have a question about for more information.

    Thumbnail 
    Attribute
    Filename
    Data Entry
    Layout

Click Standard click Pop-up Menus on the left for help on 
other pop-up menus.



Technical support
Technical support
How to contact us

Please prepare the following information before contacting 
us so we can offer you the best possible support:

The program name and serial number.
Nature of the problem.
Any error messages or dialog boxes that appear 

when the problem occurs.
System information including CPU, operating 

system, and any other programs running when the problem 
occurs.

If you write or fax us, please add printouts of the following:
AUTOEXEC.BAT
CONFIG.SYS
WIN.INI
ULEAD.INI

Note: You can open most of these files at once by running 
SYSEDIT.EXE, found in your Windows program directory.

How to contact us
Technical support
How to contact us

Click below for more information on contacting us.
North and South America  

International

. Phone .

. Fax .

. Mail .

. BBS .

. e-Mail .

Call 

+886-2-764-8599 



Send a fax to

+886-2-764-9599



Send a letter to

Ulead Systems, Inc.
10 F, 111 Tung Hsing St,
Taipei, Taiwan, R.O.C.



WWW

http://www.ulead.com
E-Mail

mkt@ulead.com.tw
Dial up the Ulead BBS at

+886-2-764-7585 19200 bps (N,8,1)

Compuserve

GO ULEAD



Call

(310)-523-9391



Send a fax to 

(310)-523-9399



Send a letter to

Ulead Systems, Inc.
970 West 190th Street, Suite 520
Torrance, CA 90502



WWW

http://www.ulead.com
E-Mail

mkt@ulead.com
Dial up the Ulead BBS at

(310)-523-9389 19200 bps (N,8,1)

Compuserve
GO ULEAD



Send e-Mail to

support@ulead.com.tw



Search Type
Allows you to select a criteria to search on.

Search Operator
Allows you to select the operator to use in a search. The 
available list varies depending on the selected search type.

Enter Data to Search on
Allows you to enter the data to match with thumbnails' data 
in a search.

Start with
Allows you to search for thumbnails with words that begin 
with the text you entered. 

Edit Criteria    
Opens the Edit search criteria dialog box to define/edit the 
search criteria.

Perform Search    
Searches and displays all thumbnails matching the defined 
search criteria.

Sort by    
Defines the order of thumbnails in an album.

Sort by Name    
Sorts thumbnails alphabetically by the filename of their 
source files.

Sort by Extension    
Sorts thumbnails by the file extension of their source files.

Sort by Size    
Sorts thumbnails by the file size of their source files.

Sort by Date    



Sorts thumbnails by the date their source files were last 
modified 

Auto Scroll
Allows you to quickly scroll through the thumbnails in an 
album. Click on the red dot and while holding down the left 
mouse button, turn the dial clockwise to scroll down or 
counter clockwise to scroll up. To stop the process, release 
the mouse button.

Tool Panel Menu    
Opens the Tool Panel Menu which allows you to add/delete 
program groups and icons, display/modify the Tool panel 
properties, change the Tool panel location, and run other 
programs even if they are not included in the Tool panel.

 
    Adding programs
    Removing programs and program groups
    Displaying a program group
    Repositioning the Tool panel

Scroll buttons
Allows you to see other program icons not visible on the 
screen.

Program icons
Clicking on a program icon in the Tool panel opens the 
program. Dragging and dropping thumbnails to a program 
icon that supports their file format runs the program, opening
the selected thumbnail files in the workspace. 

    Adding programs
    Removing programs and program groups
    Displaying a program group

Move
Allows you to position the Mark panel anywhere on the 
desktop.

Size
Allows you to resize the Mark panel.

Close
Allows you to hide the Mark panel.



Assign Selected    
Allows you to assign selected marks to thumbnails. 

    Assigning marks

Clear Selected
Removes selected marks from the selected thumbnails.

Clear All
Removes all selected marks from all thumbnails.

Edit
Allows you to define a new mark or edit the existing ones.

Load
Allows you to retrieve previously saved mark file of the 
selected thumbnail(s). Album matches the mark names in 
the selected mark file to the ones in the current list before 
putting marks on thumbnail(s). When a mark letter conflict 
occurs, the program prompts you to select a new mark letter
to assign to the incoming mark name or cancel the insertion 
process. 

    Loading marks

Save
Allows you to save current marks of the selected 
thumbnail(s) to a mark file for future use.

    Loading marks

Convert to Keywords
Allows you to add the selected mark names to your keyword
list. A dialog box opens for you to select the keyword field, 
define the marks to add, and decide whether to remove the 
marks from the thumbnails and/or the Mark panel.

View Marks    
Displays thumbnails with or without marks in an album. 
Select one or multiple marks from the list. Select the 
operator (AND or OR) to display the thumbnails bearing the 
selected marks.

New
Creates a new program group and/or adds program icons to



a group in the Tool panel.

    Adding programs 

Delete
Removes a program group together with its program icons 
and/or removes a program icon from a program group.

    Removing programs and program groups 

Properties
Allows you to edit/change a program group name and 
program icon information of the selected program group.

    Changing properties of a program 

Program Group list
Displays all the existing program groups in the current 
album. To display a program group, click on the desired 
program group.

    Displaying a program group 

Configure
Allows you to change the location of the Tool panel.

    Repositioning the Tool panel

Run
Allows you to start an application even if it is not included in 
the Tool panel.

(Hot Key - Ctrl+R)

Information displayed in the Status bar
Information varies depending where the pointer rests. Listed
below are examples of what you might expect.

Displays the number of albums in the 
workspace/on the shelf.

Displays the total number of thumbnails in an 
album.

Displays the number of thumbnails in a tab.
Displays the number of selected thumbnails in an 

album.

Compact Mode menu bar commands
Displays all the menu bar commands. To view a command, 
highlight a particular menu.



    Controlling Album's workscreen

Tile With
Allows you to display an album and another opened 
application on the screen. A dialog box offers options on 
where to place your album and the selected application.

    Controlling Album's workscreen
    Displaying another program with Album

Always on Top
Ensures that Album is never covered by any other open 
applications on your desktop. This command is useful when 
performing drag-and-drop operations.

    Displaying another program with Album

Horizontal Panel
In compact mode, Album is displayed horizontally at the 
lower part of the screen.

    Displaying another program with Album

Vertical Panel
In compact mode, Album is displayed vertically at the right 
most part of the screen.

    Displaying another program with Album

Switch To
Allows you to switch from one album tab to another.

Move Thumbnail
Allows you to move selected thumbnails from one tab to 
another within an album.

Standard
Allows you to display the standard toolbar by highlighting it. 
(A check mark to its left means it's already displayed.)

Sort
Allows you to display the sort toolbar by highlighting it. (A 
check mark to its left means it's already displayed.)

Search



Allows you to display the search toolbar by highlighting it. (A 
check mark to its left means it's already displayed.)

Tool panel
Allows you to display the Tool panel by highlighting it. (A 
check mark to its left means it's already displayed.)

Mark panel
Allows you to display the Mark panel by highlighting it. (A 
check mark to its left means it's already displayed.)

Status bar
Allows you to display the status bar by highlighting it. (A 
check mark to its left means it's already displayed.)

Tool panel position
Allows you to select where to position the Tool panel. (A 
check mark indicates the current position.)

 Note: Selecting floating allows you to drag the Tool panel 
anywhere on the screen.

More
Allows you to view other opened albums in the workspace 
that exceeds the filename display limit of nine. 

Minimize All
Minimizes all opened albums in the workspace.

Undo
Reverses the last action made on the current field of the 
displayed thumbnail.

Cut
Removes the selected text from the current field of the 
displayed thumbnail and transfers it to the clipboard.

Copy
Copies the selected text from the current field of the 
displayed thumbnail onto the clipboard.



Paste
Allows you to copy clipboard data to a selected field of the 
displayed thumbnail.

Clear
Deletes the selected text from the current field of the 
displayed thumbnail.

Apply to All
Copies the field data of the current field to the corresponding
fields of all selected thumbnails.

Save
Saves the modified field data of the displayed thumbnail to 
the album.

Restore
Restores all the field data of the displayed thumbnail from 
the album and deletes modified data entries. 

Mark Panel Menu
Displays the Mark panel menu to resize and reposition the 
Mark panel. It also contains commands for working with 
marks.

    Assigning marks
    Editing and adding marks
    Loading and saving marks

Mark names window
Displays all the mark names in an album. 

    Assigning marks
    Editing and adding marks

Assign marks    
Allows you to assign selected mark(s) to thumbnails. To 
start/stop assigning marks to thumbnails, click .

File & Album    
Allows you to input images from the installed TWAIN device 



and then sends the files to an album.

Fax in B&W    
Allows you to input images from the installed TWAIN device 
and then sends them as a black and white fax.

Fax in Color    
Allows you to input images from the installed TWAIN device 
and then sends them as a color fax.

Printer    
Allows you to input images from the installed TWAIN device 
and then sends them to the default printer.

e-Mail    
Allows you to input images from the installed TWAIN device 
and then sends them to your e-Mail delivery system.

Acquire To    
Allows you to input images from the installed TWAIN device 
and then sends them to different locations, such as an 
album, fax, or e-Mail.

Top
Displays the first thumbnail in the currently selected set of 
thumbnails when in the Data Entry mode.

Backward
Displays the previously viewed thumbnail in the currently 
selected set of thumbnails when in the Data Entry mode.

Forward
Displays the next thumbnail in the currently selected set of 
thumbnails when in the Data Entry mode.

Bottom
Displays the last thumbnail in the currently selected set of 
thumbnails when in the Data Entry mode.



Select Item
Allows you to select an item to search for from the drop 
down list. The items listed varies depending on the selected 
search type.

Date range
Allows you to specify the range of date to search on. Enter 
the month, day, and year, respectively.

File size range
Allows you to specify the file size to match in the search. 
Select the unit of measure to use and enter the size range of
the files as well as the data to match.

Match whole word
Allows you to search for occurrences of a defined query 
(upper and lower cases of the letters not considered).    
When this option is not selected, the search result displays 
all the words that contain all the letters in the defined query 
even if the query is only a part of the found match. 

Match case
Allows you to search for an exact match of a defined query. 
(This process considers the upper and lower cases of the 
letters.)

More Groups
Displays other group names that are not visible on the 
screen.




